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Bu uslubiy ko'rsatmada rastrli kompyuter grafikasining eng ko'p targalgan Adobe
Photoshop dasturi bilan tanishib chigish bo'yicha amaliy va laboratoriya ishlarini bajarish
bo’yicha ko'rsatmalar berilgan. Shuning bilan birga dasturda ishlash bo’yicha xam ko’rsatmalar,
ya’ni bosh menyu bo'limlari, uskunalar paneli, rasm chizish, matn yaratish va turli tahrirlash
ishlarini bajarish xagida ma'lumotlar keltirilgan.

«Kompyuter grafikasi» fani turli texnik ta'lim yo'nalishlari jumladan televideniya, kino va
boshqa kadrlarni tayyorlashda fundamental ahamiyatga ega bo'lgan mustagil fan hisoblanadi.

Bakalavrlar nazariy olgan bilimlarini amaliy va laboratoriya ishlarini bajarishi natijasida
0'z mutaxassisliklarida zamonaviy kompyuter texnologiyalaridan to'lagonli foydalanish
ko'nikmasiga ega bo'ladilar.

Ushbu uslubiy ko'rsatma «Kompyuter grafikasi» fanidan amaliy va laboratoriya ishlarini
o'tkazishda nafagat bakalavrda ta'lim olayotgan talabalarga, balki magistrlar, o'gituvchilar
foydalanishlari uchun xam tavsiya etiladi.

«Informatika va tabiiy fanlar» kafedrasi. O‘zbekiston davlat san’at va madaniyat
instituti ilmiy-uslubiy kengashi karori asosida nashr etildi.( - gaydnoma, )

Tagrizchilar:
1. TTYMI - dots. Ibragimov R.1.

2. TATU - dots. Xaydarova M.Y.

© O‘zbekiston davlat san’at va madaniyat instituti 2012.



ADOBE PHOTOSHOP grafik dasturida ishlash

ADOBE PHOTOSHOP Windows muhitida ishlovchi kompyuterlar uchun mo‘ljallangan
elektron ko‘rinishdagi fototasvirlarni tahrir va dizayn qiluvchi dasturdir.

Adobe Photoshop tasvir tahrir qiluvchisi yordamida fotosuratlarga qo‘shimcha
o’zgartirishlar Kiritish, fotosuratdagi dog‘larni o‘chirish va eski rasmlarni gayta ishlash va
tiklash, rasmlarga matn Kiritish, qo‘shimcha maxsus effektlar bilan boyitish, bir fotosuratdagi
elementlarni o‘zgartirish, almashtirish imkoni mavjud. Adobe Photoshop dasturi imkoniyatlari
keng gamrovli bo‘lib, kitoblar, gazeta va jurnallarni turli-tuman rasmlar bilan boyitishda katta
qulayliklar yaratadi.

Adobe Photoshop aynigsa jurnalistlarning, rassomlarning ijodiy imkoniyatlarini to‘la
amalga oshirishlarida yordam beradi. Jurnalistika va bevosita matbuot yoki nashriyot sohasiga
alogador bo‘lgan shaxslarning mazkur dastur bilan ishlashni bilishi ular uchun qo‘shimcha
imkoniyatlarni yaratib beradi. Adobe Photoshop dasturi quyidagicha ishga tushiriladi:

1. Pusk menyusi Programmi yoki Vse programmi bandining Photoshop CS belgisida
«sichgonchay ni bosiladi.

2. Windows ishchi stolida mavjud Adobe Photoshop uchun maxsus belgida «sichgonchax
ning chap tugmasi ikki marta bosiladi.

Adobe Photoshop dasturi ishga tushirilgandan so‘ng ekranda Adobe Photoshop tasvir
tahrir giluvchi oynasi hosil bo‘ladi.
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Dasturdan chigish uchun quyidagi usullarni biridan foydalanish mumkin:
1. Alt + F4 tugmalarini birgalikda bosish.
2. Fayl menyusidagi Vixod buyrug‘ini tanlash bilan.
3. Ekranning yuqori gismi o‘ng burchagida joylashgan X belgisini bosish yoki
Zakrit buyrug‘ini bajarish bilan. Dasturni yopishda qiyidagi so’rov paneli ochiladi va bu
savollarga

Microszoft Word |
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DA — kiritilgan matni o‘zgarishlarni saglash va dasturidan chigish uchun.
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NET — kirtilgan matnda o‘zgartirishlar saglanmagan xolda dasturidan chigish uchun.
Otmena - dasturda ishlashni davom ettirish uchun.
Adobe Photoshop oynasining yuqori gismida sarlavha satr va Windowsga xos elementlar

joylashadi. Sarlavha satridan so’

ng bosh menyu satri joylashadi. Menyudagi kerakli buyruglarni

ish vazifasiga mos buyruglarni tanlashingiz mumkin.

Adobe Photoshop dasturi

menyusi 9 banddan iborat. Har bir menyu tarkibida ochiladigan

menyu banddlari mavjud. Ularni ko‘rish kursor yordamida amalga oshirishladi. Quyida asosiy
menyu va eng ko‘p qo‘llaniladigan buyruglarning gisgacha tavsifi keltiriladi.

FAYL menyusi quyidagi buyruglardan iborat:

Noviy (Ctrl+N)
Otkit(Ctrl+0)

Otkrit kak (Alt+Ctrl+0O)
Soxranit (Shift+ S)
Soxranit kak

Soxranit Kopiyu
(Alt+Ctrl+S)

Vernut

Pomestit

Import

Eksport

Fayl informatsiya
Ustanovka stranitsi
Pechat (Ctrl+P)
Predpochteniya
Nastroyka sveta
Adobe online
Vixod (Ctrl+Q)

Pravka
Vernut (Ctrl+2)
Rezat (Ctr+X)

Kopirovat (Ctrl+C)
Vstavit (Ctrl-V)

Vstavit V (Shift+Ctrl+V)
Ochistit

Zalit

Shtrix

Transformatsiya (Ctrl+T)
Transform

Ochistka

Yangi fayl yaratish.

Bu buyrug yordamida diskda m avjud fayllar ochiladi.
Faylni ganday ko‘rinishda ochishni tanlash.

Faylga nom berish

FaylIni xotiraga boshga nom bilan (Shift+Ctrl+S) saglash
Tasvir nusxasini xotiraga saglash.

Tasvirning dastlabki holatiga gaytish.
Boshga mustaqil fayl bilan birlashtirish.
Boshqga direktoriyada joylashgan faylni Adobe Photoshop
dasturiga
olib kirish.
Tasvirni boshga dastrularga jo‘natish.
Fayl hagidagi malumotlarni Kiritish.
Ochilgan fayldagi betini shaklini (Shift+Ctrl+P) tanlash.
Tasvirni printerga jo‘natish.
Adobe Photoshop dasturini kerakli tartibda sozlash.
Tasvir ranglarini sozlash.
Internet bilan bog*lanish.
Dasturdan chiqgish.

menyusi quyidagi buyruglardan iborat:
Tasvir ustida bajarilgan oxirgi amalni bekor gilish.
Tasvirning ajratilagan gismini girgib olish va kerakli
joyga qo‘yish yoki butunlay qirgib tashlash.
Tasvirni belgilangan gismini nusxaga olish.
Xotiraga olingan tasvirni belgilangan joyga qo‘yish.
Tasvirda belgilangan maydonni tozalash, o‘chirish.
Bunda ichirilgan maydon fon rangiga bo‘yaladi.
Tasvir yuzini rang bilan bo‘yash.
Tasvirda belgilangan maydonni shtrixlab ko‘rsatish.
Tasvir shaklini o‘zgartirish.
Tasvir shaklini turli ko‘rinishlarda o‘zgartirish.
Istoriya darchasida tasvir olib borilgan o‘zgartirish
amallarini butunlay o‘chirish. Bu amal bajarilgandan
sing o‘zgartirishlarni ortga gaytarish mumkin emas.

IZOBRAJENIYA menyusi quyidagi buyruglardan iborat:

Rejim

Nastroyka

Dublikat

Nalojit izobrajeniye

Rang modellarni o‘zgartirish.

Tasvir ranglarini sozlash.

Tasvirdan nusxa olish.

Tasvirni go‘shimcha ranglar bilan boyitish.
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Vichislit

Razmer izobrajeniya
Razmer xolsta
Obrezaniye
Perevernut xolst

Gistrogramma

Tasvirdagi ranglar kanallarni o‘chirish.

Tasvir shaklini va o‘lchamlarini o‘zgartirish.

Tasvir ramkasi o‘lchamlarini o‘zgartirish.
Belgilangan maydondagi tasvirni kesib olish.

Xolstni soat strelkasi bo‘ylab yoki soat strelkasiga
garshi 180, 90 gradusga burish.

Tasvirdagi ranglar migdori hagidagi ma’lumotlar
darchasi.

Sloy menyusi tarkibidagi qo‘shimcha buyruglar

Noviy

Dublikat sloya

Udalit sloy

Effekti

Gruppa s predidushim (Ctrll+G)
Razgrupirovat(Shift+Ctrll+G)
Skleit vse sloi

Yangi gatlamni tashkil gilish.

Qatlam nusxasini xosil gilish.

Mavjud gatlamni muvaqgqgat xotiradan o‘chirish.
Qatlamga turli effektlarni qo‘yish.

Bir nechta gatlamlarni gruppalash.
Gruppalangan gatlamlarni bir-biridan ajratish
Barcha gatlamlarni birlashtirish.

VIDELIT menyusi quyidagi buyruglardan iborat :

Vse (Ctrll+A)

Ubrat videleniye (Ctrll+D)
Videlit zanovo
(Shift+Ctrll+D)

Obratno (Shift+Ctrl)
Svetovoy ryad

Modifitsirovat
Uvelichit

Preobrazovat videleniye
Soxranit videleniye

Tasvirni butunlay belgilash.
Tasvirning belgilangan gismini olib tashlash.
Qaytadan belgilash.

So‘ngi bajarilgan amalga gaytarish.

Ranglar gatori. Tasvirdagi ranglar asosida belgilash
maydonini aniglash.

Belgilash chizig‘ini piksellarda kengaytirish.
Belgilash maydonini kengaytirish.

Belgilangan maydon shaklini o‘zgartirish
Belgilangan maydon shaklini xotiraga joylashtirish.

VID menyusi quyidagi buyruglardan iborat :

Noviy vid

Uvelichit (Ctrl++)
Umenshit (Ctrl+-)

Pokazat ves ekran

Realniy razmer

Razmer pechatnogo ottiska
Vikl. lineyki (Ctrl+R)

Yangi darchada ochish.

Tasvirning ekrandagi ko‘rinishini kattalashtirish.
Tasvirning ekrandagi ko‘rinishini kuchaytirish.
Tasvirini butun ekran ko‘rinishida ko‘rsatish.
Tasvirini mavjud o‘lchamlaridagi ko‘rinishi.
Tasvirning bosma shakldagi ko‘rinishi.
Chizg‘ichlarni olib tashlash.

OKNO menyusi quyidagi buyruglardan iborat :

Kaskad
Mozayka
Upodryachit znachki

Zakrit vsyo

VKI. Panel

VkI. Navigator
Pokazat informasiyu
Pokazat svet

Tasvirni ekranda vertikal xolatda tasvirlash.

Tasvirni ekranda gorizontal xolatda tasvirlash.
Uskunalar  panelidagi  buyruglarni tartibli
joylashtirish.

Photoshop darchasida ochilgan barcha tasvirni
berkitish.

Uskunalar panelini o‘chirish yoki yoqgish.
Navigatorning ekranda paydo bo‘lishini ta’minlash.
Axborotlar darchasini aktivlashtrish.

Ranglar joylashgan maxsus darchani aktivlashtirish.



VK. Kisti Bo‘yoq cho‘tkalari joylashgan darchani
aktivlashtirish.

VKkl. Sloy Qatlamlar  hagidagi ma’lumotlarni  saglovchi
darchani aktivlashtirish.

Pokazat deystviya Tasvirlar bilan ishlashda bajarilgan barcha amallar
hagidagi ma’lumotlar darchasini aktivlashtirish.

Ubrat stroku sostoyaniya Photoshop dasturi darchasi ostidagi ma’lumotlar

satrini o‘chirish yoki yogish.

FILTRI menyusi tarkibidagi go‘shimcha buyruglar bilan go‘llanmaning fitrlar bilan
ishlash bobida tanishingiz mumkin.

POMOSH menyusi tarkibida Adobe Photoshop dasturiga ta’llugli barcha ma’lumotlar
joylashgan. Bu menyu tarkibidagi buyruglar yordamida Adobe Photoshop dasturi darchasidagi
uskunalarning gisgacha ganday vazifani bajarishi hagidagi ma’lumotlarni o‘gish mumkin.

Uskunalar paneli. Adobe Photoshop uskunalar panelida turli xil ishni bajariadigan
oynalar joylashgan. Har biri Adobe Photoshop dasturining biror-bir buyrug‘ini anglatadi. Agar
uskunalar panelida biron-bir oyna bo‘lmasa, menyu satring Okno punktida Vkl. Panel
buyrug‘ini tanlang.

Adobe Photoshop dasturida jami 46 ta uskunalar mavjud bo‘lib, ulardan 20 tasi bevosita
dastur ishga tushirilganda oynada ko‘zga tashlanib turadi. Qolganlarini go‘shimcha buyruglarni
bajarish orgali ishga tushirish mumkin. Agar uskunalar panelida joylashgan oynaning ostki gism
o‘ng burchagida kichik uchburchak shakli tasvirlangan bo‘lsa, bu tasvir ushbu oyna tarkibida
o‘xshash buyrugni bajaruvchi uskunalar yashiringanligidan darak beradi.

Yashiringan uskunani aktivlashtirish uchun kursorni maxsus belgili oyna ustida
«sichgonchay» ning chap tugmasini bosgan holda uskunalar panelidan tashqariga olib chigariladi
va kerakli oyna ustida kursorni goldirib «sichqonchax» ning chap tugmasi go‘yib yuboriladi.

Har bir oynaga kursor yaqinlashtirilsa, kursor belgisi ostidagi uskunaning ganday vazifani
bajarishi xaqidagi axborot paydo bo‘ladi.

Quyida Adobe Photoshop dasturida ishlash jarayonida keng qo‘llaniladigan
uskunalarning gisgacha tavsifi keltiriladi.

D Pryamougolnaya oblast: To‘g‘ri to‘rtburchak shaklidagi maydonni belgilab olish uchun
go‘llaniladi. Bu uskuna yordamida tasvirdagi alohida maydonni belgilab olingandan keyin
tasvirga Kiritilgan barcha o‘zgarishlar fagat belgilangan maydon ichiga ta’sir etadi. Ushbu
oynaga go‘shimcha tarzda Shift klavishi ishlatilsa, belgilangan maydon xududi ortadi. Shift
klavish o‘rnida Alt klavishi go‘llanilgan tagdirda belgilangan maydon xududi gisqaradi. Ushbu
amal Lasso va Volshebnaya palochka uskunalari bilan ishlashda go‘llaniladi.

|| Ellipticheskaya oblast: Doira shaklidagi maydonni belgilab olish uchun go‘llaniladi. Bu
oyna yordamida tasvirdagi alohida maydonni belgilab olingandan keyin tasvirga Kkiritilgan
barcha o‘zgarishlar fagat belgilangan maydon ichiga ta’sir etadi.

Stroka pikseley: tasvirda gorizontal shakldagi chizigni belgilaydi. Amalda bu oyna juda
kam go‘llanildi.

Stolbes pikseley: Tasvirda vertikal shakldagi chizigni belgilaydi. Amalda bu oyna ham
juda kam uchraydi.

B Kadrirovaniye: Ushbu oyna, asosan tasvir chetlarini va keraksiz gismlarini kesib tashlash
uchun go‘lllaniladi. Bu buyruq aktivlashtirilganda tasvir yuzida to‘g‘ri to‘rtburchak shaklidagi
ramka hosil bo‘ladi. Ramkaning chetlari kichik kvadratlardan iborat bo‘lib, bu kvadratchalar
yordamida ramka hajmi o‘zgartiriladi. Tasvir ramka ostiga olingandan so‘ng Enter klavishi
bosilsa, ramka tashqarisida golgan ortigcha bo‘laklar kesib tashlanadi. Ushbu buyrugni Esc
klavishini bosib rad etish mumkin.




I g Peremesheniye: Ushbu oyna tasvirdagi belgilangan maydonni yoki gatlamni siljitish va
kesib olish uchun hizmat giladi. Peremesheniye buyrug‘ini bajaradigan ayni jarayonni boshga

ayrim oynalar (masalan |"+| . | Volshebnaya palochka oynasi) yordamida ham amalga
oshirish mumkin.

K

i| Mnogougolnoye Lasso: Asosan tasvirdagi to‘g‘ri chiziglardan iborat obyektlarni
belgilashda ishlatiladi. Alt klavishi qo‘llanilganda oddiy Lasso oynasi vazifasini bajaradi.

Lassol: tasvirdagi turli shakldagi ob’ktlarni belgilash uchun ishlatiladi.

| Magnitnoye Lasso: Bu oyna ishlatilganda Adobe Photoshop dasturi tasvirdagi obyekt
chegaralarni o‘zi belgilaydi. Ammo bu oyna piksellardagi ranglarni o‘zgarishiga bog‘liq tarzda
chegaralarni aniglashi bois kam go‘llaniladi.
> Volshebnaya palochka: Bir-biriga yaqin bo‘lgan rangdagi piksellar joylashgan maydonni
belgilaydi.  Shift bilan birgalikda go‘llansa, belgilangan maydon hajmi ortadi. Alt bilan
ishlatilganda esa belgilangan maydon hajmi kamayadi.

54 Aerograf: tasvirini bo‘yashda ishlatiladi. Aerografni bir joyda ushlab turish siyohni tasvir
bo‘ylab yoyilib ketish effektini beradi. Bo‘yogning tasvir bo‘ylab ogqishi kursorni qo‘yib
yuborguncha davom etadi. Odatda bu uskuna yumshoq cho‘tkalar ishlatiladi. Aerograf kursorni
ushbu uskuna ustida bosish yoki klaviaturadagi J klavishini bosish orqgali aktivlashtriladi.

P

_| Kist: Aerograf oynasi kabi tasvirni bo’yashda ishlatiladi. Ammo Kist yordamida tasvirni
sifatli bo’yash mumkin. Bu oyna aerografga nisbatan ko‘p go‘llaniladi. Kist oynasini V
klavishini bosish orgali aktivlashtirish mumkin. Brushes oynasi yordamida bo‘yoq cho‘tkalarini
sﬂilni o‘zgartirish mumkin.

é' Shtamp: tasvirdagi Kichik bir bo‘lak nushasini ko‘chirish uchun ishlatiladi. Bu oyna
tasvirdagi ayrim nugsonlarni, dog‘larni yo‘qotish va eski rasmlarni tiklashda keng go‘llnailadi.

E Kist predidushix sostoyaniy: Bu oyna tasvir hagidagi dastlabki ma’lumotlar asosida
ishlaydi. Uning yordamida tasvirga kiritilgan so‘ngi o‘zgartirishlarni bekor gilish mumkin.
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4 Lastik: tasvirni o‘chirish uchun ishlatiladi. U go‘llanganda tasvirda fon qaysi rangda
bo‘lsa, o‘sha rangdagi chiziglar hosil bo‘ladi. Alt klavishini go‘llash yordamida kompyuter
xotirasiga olinmagan so‘ngi o‘zgartirishlarni bekor gilish mumkin. LASTIK uskunani YE
klavishni bosish orqali aktivlashtiriladi.

ﬁ.' Karandash: turli chiziglarni chizish uchun foydalaniladi. Alt klavishi bosilganda
kursorning ekrandagi tasviri o‘zgaradi va bevosita tasvirdan kerakli rangni tanlash mumkin. Bu
amal bajarilgandan so‘ng o°sha rangda chizq tortadi.

Liniya: To‘g‘ri chiziglarni chizishda qo‘llanilaniladi.

Razmivka: Ushbu oyna ishlatilganda, tasvirdagi yorginlik pasayadi. Alt klavishi bilan
go‘llanganda yorqginlik ortadi.

Rezkost: Ushbu oyna ishlatilganda tasvirdagi yorginlik ortadi. Alt Kklavishi bilan
go‘llanganda esa tasvir hiralashadi.

u Pales: Tasvirdagi ranglar chayqaltirib, tasvirdagi obyektlar o‘rtasidagi chegaralarni bir-
biriga qo‘shishga xizmat giladi.



JLI Osvetitel: Piksellardagi ranglar yorginlashadi. Alt klavishi bilan go‘llanganda esa
piksellardagi ranglar hiralashadi.
Zamenitel: Tasvir ustida harakatlantirilganda piksellardagi ranglar goramtil tus oladi.
Gubka: Tasvir ustida xarakatlantirilganda, tasvirdagi ranglar migdori pasayadi. Gubka
bir jOfda ko‘p aylantirilsa, tasvirning o‘sha joyi kulrang tus oladi.

—— Pero: Peroni tasvir ustida xaraktlantirilganda, nuqtalar xosil bo‘ladi. Ushbu nugtalar
yordamida chizilgan tasvirni o‘zgartirsh mumkin.

Magnitnoye pero: Bu uskuna xuddi magnitnoye lasso kabi xarakatlanadi. Biror bir
tasvirdagi obyekt atrofida xarakatlantirilganda, Adobe Photoshop dasturining o‘z  obyekt
chetlarini belgilab chigadi.
¢_| Proizvolnoye pero: juda qulay oyna bo‘lib, xoxlagan shakldagi tasvirni u yordamida
ifodalash mumkin.

v Vstavit tochku: Bu oyna pero yordamida chizilgan chiziq ustiga go‘shimcha nugtalarni
go‘shadi.

&_
I_ Udalit tochku: pero yordamida chizilgan chiziq ustidagi ortigcha bo‘lgan nuqtalarni
o‘chiradi.

h Neposredstvennoye videleniye: U yoki bu pero bilan chizilgan chiziglarni tahrir gilish
uchun hizmat qgiladi.

Uning yordamida chiziqgdagi nuqgtalarni yakka tartibda harakatlantirish va kerakli joyga
siljitish mumkin.

Preobrazovat tochku: Tasvir ustida chizilgan chizigchalarda o‘rnatilgan har bir nuqta,
burchak yoki yoy vazifasini bajaradi. Ushbu oyna yordamida nuqtalarning vazifalarini
o‘zgartirish, yani yoyni burchakka va burchakni yoyga almashtirish mumkin. Buning uchun
kursorni nuqta ustiga olib borib «sichqonchax ning chap tugmasi bir marta bosiladi.

]E‘ Tekst: Ushbu uskuna yordamida tasvirga turli matnlarni Kiritish mumkin. Tekst oynasi
aktivlashtirilib, kursor tasvir ustida bosilsa, matn kiritish uchun alohida darcha hosil bo‘ladi. Bu
darchada xarf o‘lchami, turi, rangi va boshga o‘lchamlari kiritiladi. Bu uskuna yordamida
kiritilgan matnlarni gayta tahrir gilish imkoni mavjud emas. Tekst uskunani aktivlashtirilib,
kursor tasvir ustida bosiladi, matn kiritish uchun alohida darcha hosil bo‘ladi. Bu darcha harf
o‘lchami, turi, rangi va boshga o‘lchamlari kiritiladi. Bu uskuna yordamida kiritilgan matnni
gayta tahrir gilish imkoni mavjud emas.

—1 Tekst-Maska: Tekst oynasi kabi bu uskuna aktivlashtirilib, matn ustida bir marta
bosiliganda, Tekstoviye istrument darchasi hosil bo‘ladi. Lekin bu oddiy tekstdan tubdan farq
giladi. Harflarning cheti huddi Lasso oynasini belgilash kabi ko‘rinishga ega bo‘ladi. Harflarni
turli ranglarga bo‘yash va Peremesheniye: Oynasi yordamida o‘rnidan siljitish yoki boshga
rasmga olib o‘tish mumkin.

[x Vertikalniy tekst: agar tasvirga pastdan yuqgoriga shaklda (vertikal shaklda) matn
kiritmoqchi bo‘lsangiz ushbu uskunadan foydalanishingiz mumkin.

[z Vertikalnaya tekst-maska: Tekst-maska oynasi bir xil vazifani bajaradi. Ammo bu oyna
go‘llanganida harflar ustma-ust ustun kabi joylashtiriladi.

Izmenit: Tasvirda turli o‘lchovlarni bajarish uchun ishlatiladi. Bu uskuna bilan bir
nugtadan ikkinchi nugtaga kursor olib borilishi kifoya. Adobe Photoshop dasturi avtomatik
tarzda ikki nuqta orasidagi masofani o‘Ichaydi.



’E Gradint: Bu uskuna ishlatilganda, tasvirdagi belgilangan maydonda ranglar
kombinasiyasi hosil bo‘ladi. Asosiy rangning tasvir foniga sizib o‘tish effekti hosil bo‘ladi.

Kovsh: Ushbu oynadan, asosan, tasvirni yoki tasvirdagi ajratib olingan hududni
bo‘yashda foydalaniladi. Ranglarni go‘shimcha buyruglarni bajarish orqgali tanlanadi. Bu
uskunani aktivlashtirish uchuni K klavishi bosiladi.

; «fﬁ' | Pipetka: Tasvirdagi asosiy yoki tasvir foni rangini o‘zgartiradi, pipetka tasvir ustidagi
biror nugtada rang sifatida tanlanadi. Agar ayni jarayonga Alt qo‘shilsa, tanlangan rang tasvir
fonini o‘zgartirishga olib keladi.

Viborka svetov: Ushbu oyna tasvirdagi ranglar hagida axborot olishga hizmat giladi.
Info darchasida belgi go‘yilgan nuqgtada necha foiz gizil, ko’k va qora ranglar mavjudligi
haqgidagi axborot hosil bo‘ladi.

T

7 Ruka: Tasvirning ko‘zga tashlanmay turgan gismlarini ko‘rsatadi. Buning uchun ushbu
uskuna aktivlashtirilib tasvir ustida «sichgoncha» ning chap tugmasini bosgan holda kerakli
tomonga harakatlantiriladi. Ayni jarayonni Adobe Phtoshop dasturi darchasidagi Navigator
yordamida ham amalga oshirish mumkin.

3 Masshtab: Tasvirni kattalashtirish yoki kichraytirish uchun hizmat giladi. Agar ushbu
oyna bilan birgalikda Alt Kklavishi ishlatilsa, tasvir kichrayadi. Kursor ushbu uskuna
aktivlashtirilgandan so‘ng o‘z shaklini o‘zgatiradi va lupa ko‘rinishini oladi. Kursor tasvirning
gaysi nugtasida bosilsa, adobe Photoshop dasturi avtomatik tarzda o‘sha nugtani ekranga
yaginlashtiriladi. Masshtab uskunani aktivlashtirilib, Enter klavishi bosilsa, Opseiya
mashtabirovaniya oynasi ochiladi. Bu oynada maxsus to‘rtburchak ichiga belgi go‘yiladi, tasvir
o‘lchamlari o‘zgartirilganda tasvir oynasi xam mos tarzda o‘zgartiriladi. Har safar tasvir
o‘lchamlari Kattalashtirish yoki kichraytirish uchun masshtab uskunani aktivlashtirish zarur
emas. Boshga oyna bilan ishlash paytida Ctrl+PROBEL bosilsa, ishlatilayotgan oyna
vagtinchalik masshtab oynasini vazifasi bajaradi va tasvir kattalashadi. Ctrl + PROBEL o‘rnida
Alt +PROBEL qo‘llanilsa, tasvir  o‘lchami kichrayadi. Shuningdek, tasvir o‘lchamini
Ctrl+(plyus) klavishlari yordamida kattalashtirish yoki Strl - (minus) yordamida kichraytirish
mumkin. Adobe Photoshop dasturi oynasi ostida stroka sostoyaniya satrida tasvir o‘lchamlari
hagida axborot beruvchi mahsus oyna mavjud. Bu oyna tasvir o‘lchamlari sonlarda ifodalangan.
Ushbu sonlarni o‘zgartirish orgali tasvirning aniqg o‘lchamlari kiritiladi.

[
@ Osnovnoye svet: Ushbu oyna ustida kursor ikki marta ketma-ket bosilganda Adobe
Photoshop dasturining yangi oynasi (Vibor sveta) hosil bo‘ladi. Bu oynada kerakli rang tanlanib,
OK yoki ENTER tugmasi bosiladi va tanlangan rangni karandash, kist, aerograf, gradiyent kabi
oynilari yordamida go‘llash mumkin.

L% Svet fona: Ushbu tugma ustida kursor («sichqoncha» tugmasi) ikki marta bosilaganda
Adobe Photoshop dasturining yangi oynasi (COLOR PICKER) hosil bo‘ladi. Bu oynada tasvir
fonining rangi aniglanadi. Tasvir fonidagi rang lastochka va gradiyent oynalari uchun
go‘llaniladi.

E Pereklyucheniye svetov: Ushbu belgi ustida kursorni bosish asosiy rang bilan tasvir foni
ranglari o‘rni almashtiriladi.

|ﬂl Sveta po umolchaniyu: Bu belgi ustida kursorni bir marta bosish bilan asosiy rang goraga
va tasvir foni ranglari oqga aylanadi.

Fant!
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Marshiruyushiye muravi: Bu oyna yordamida Adobe Photoshop dasturida tez nigoblash
holati bekor qgilinadi. Ekranda belgilash chegaralari chumolilar xarakatini eslatuvchi punktir
chiziq yordamida aks ettiriladi. Bu Adobe Photoshop dasturida, odatda standart holat deb ataladi.



ng Bistraya maska: Ushbu oyna ustida kursor bir marta bosilishi bilan Adobe Photoshop
dasturi tez niqoblash holatiga o°‘tadi va natijada tasvirdagi nigoblanmagan xudud gizil rang bilan
bo‘yaladi. Ushbu oyna tasvirdagi turli obyektlarni anig nigoblanishda ishlatiladi. Kist oynasi
yordamida nigobga ishlov berish mumkin. Bunda qora rang bilan tasvir nigoblanadi, oq rang
bilan tasvir rangi niqobi o*chiriladi.

(=]

—— Standartnoye okno: Oyna aktivlashtirilganda tasvir standart holatda bo‘ladi.

Polniy ekran s menyu: Bu tasvir kompyuter ekraniga sig‘magan holda ishlatiladi. Ushbu
oyna aktivlashtirilganda ekranda menyu satri hamda uskunalar paneli goladi.

El Polniy ekran: Ekranda fagat tasvir va uskunalar paneli hamda menyu satri qora fonda
goladi.

TO‘LA EKRANLI REJIM

Photoshop dasturi tasvirni birinchi marta ochganda uni maksimal o‘lchamda ochadi.
Tasvir bilan ishlash jarayonida uning o‘lchamini bir necha marta Kattalashtirish yoki
Kichraytirishga to‘g‘ri keladi. Ana shunday holatlarda tasvirni xoxlagan paytda dastlabki
Polnoekranniy rejim holatiga gaytarish mumkin. Buning uchun quyidagi amallarni bajarish
lozim:

Menyular satrida Vid menyusi tarkibidagi po razmeram ekrana komandasini tanlash:

e Ctrl+ 0 (nol) tugmalarni birgalikda bosish:

o Uskunalar penalidagi ruka oynasi ustida «sichgoncha» tugmasini ikki marta
ketma-ket bosiladi.

Adobe Photoshop dasturi tasvirning printerda chop qilingandagi ko‘rinishini chop
gilmasdan avval ekranda ko‘rish imkoniyatini beradi. Buning uchun menyular satrida
izobrajeniye menyusini tarkibidagi razmer izobrajeniya buyrug‘ini tanlanadi. Ammo, hamma
vaqt ham tasvirning ekrandagi ko‘rinishi bilan chop etilgandagi o‘lchamlari aynan mos
tushavermaydi. Tasvir kattaliklari 0,2% dan 16000 % miqgdor o‘rtasidagi sonlar bilan belgilanadi.

TASVIR FORMATLARI

Adobe Photoshop dasturi 20 dan ortiq formatdagi fayllar bilan ishlash imkoniga ega. Eng
ko‘p go‘llaniladigan format:

BMP (Windows Bitmap — Windows ning vit kartasi) - Windows muhitida ishlovchi
kompyuterlarda ekran osti tasvirlarini qo‘llovchi dastur Microsoft Paint da keng go‘llaniladi.

Jpeg (Joint Phonographic Experts Group) — hozirgi kunda eng ko‘p go‘llaniladigan
formatlardan biri bo‘lib, uning asosiy afzaliklaridan biri mahsus dastur yordamida fayl hajmini
yetarlicha sigish imkonining mavjudligidir. Ammo faylIni sigib, hajmini kichraytirish jarayonida
tasvir sifatida o‘zgarish bo‘ladi. Fayl kuchli sigilganda tasvir sifati yomonlashishi mumkin.
Ushbu formatdagi fayllar kompyuter xotirasida ko‘p joy egallamaydi va hajm jihatidan kichikligi
bois mazkur formatdagi tasvirlar bilan ishlash ancha oson.

TIFF (Tagger Image File Format) — bu formatdagi fayllar sham keng qo’illanadi. Lekin
Tiff formatidagi fayllar kompyuter xotirasida ko‘p joyni egallaydi. Adobe Photoshop dasturida
ushbu formatdagi tasvirlar bilan ishlashda dasturining ishlash tezligi  sezilarli ravishda
kamayishi mumkin.

GIF (Grapis Interchage Format- grafikni ayriboshlash formati) — ushbu formatdagi
tasvirlar 256 turdagi rang bilan tasvirlanadi. Bu formatdagi tasvirlar, asosan, internet tizimida
keng go‘llanaladi.

RANGLAR BILAN ISHLASH.

Kompyuter grafikasi 3 xil bo’ladi: rastrli (nuqtali), vektorli va fraktal. Vektorli grafika
muxarrirlariga misol gilib Adobe Illustrator, Corel Draw va Macromediya Flash dasturlarni
aytish mumkin. Ushbu dasturlarda rasmlar har xil chiziglar va qiyshiq vektorlardan iborat
bo’ladi.
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Vektorli grafikada yaratilgan rasmlar logotip, illyustratsiyalar va zastavkalar yaratishda
foydalaniladi. Rastrli grafika muxarrirlariga misol gilib Adobe Photoshop va Paint dasturlarni
aytish mumkin. Ushbu dastrularda rasmlar mayda kvadrat - piksellardan iborat bo’lib mozaika
xolatida rasmni xosil giladi. Rastrli grafikadan ragamli fotosuratlar va skanerdan olingan rasmlar
bilan ishlash uchun foydalaniladi. Kompyuter grafikada dyuymdagi piksellar soni (ppi) asosiy
shart bo’ladi. Qancha ko’prok piksellar soni bo’lsa shuncha tasvir sifatliroq bo’ladi. Masalan
agar ppi=72 bo’lsa u xolda 1 kvadrat dyuymga 5184 piskel joylashadi va uning xajmi 6 Kb
bo’ladi, agar ppi=144 bo’lsa u xolda 1 kvadrat dyuymga 20736 piskel joylashadi va endi uning
xajmi 21 Kb ga teng bo’ladi. Shu bilan birga monitorning ko’rsatish va printerning chigarish
sifati - dyuymga piskellar soni (dpi) (72 yoki 96 dpi) va dyuymga chiziglar soni (Ipi) (300-2400
dpi lazerli, sepuvchi printerlar uchun va 75-200 Ipi matritsali printerlar uchun), xamda
kompyuter ranglar sifati (2, 16, 256, 32 000, 16 000 000 ranglar soni) xam katta axamiyatga ega
bo’ladi.

Rang xolatlari - ranglarni chigarish va ko’rsatish yo’li.

Rang modellari.

Rang xolatlari 2 xil bo’ladi: RGB (qizil, yashil, ko’k) monitorlarda tasvir ko‘rsatishda
foydalaniladi, CMYK (xavorang, purpur, sarig, gora) bosmada foydalaniladi. RGB xolatidagi
ranglar soni CMYK xolatga garaganda ko’proq.

Kompyuter grafikasida rang juda muxim — ko’zatuv taassurotni kuchaytirish va tasvirni
axborotga boyitish rolini 0’ynaydi. Biz ko’rayotgan yoritilgan buyumdan gaytgan yoruq’lik ko’z
qorachiq’i orqali ko’zimizga o’tadi va ko’z ichidagi asab xujayralarini qo’zq’atadi. Bu hujayralar
asab tolalari orqali miya bilan boq’langanligi tufayli ko’z yoruq’ligi miyaga o’tadi va ongimizda
buyumni ko’rish tuyq’usi paydo bo’ladi. Biz buyumni ko’ramiz. Atrof muhitni bunday ko’rish
gobiliyati ko’rish deb, ko’rish a’zosi esa ko’z deb ataladi.

Biz sezgi organlarimiz orqali atrof muhit haqida juda ko’p ma’lumot olamiz. Bu
ma’lumotlarning 90% ni ko’rish orqali gqabul gilamiz. Yoruq’lik ogimi bu ma’lumotlarni eltuvchi
hisoblanadi.

Bizning ko’zimiz miya bilan organizmning asab sistemasi orqali boq’langan. Agar
ko’zning to’zilishini fotoapparat, kinoga olish apparati va televizion kamera kabi hozirgi zamon
optikaviy apparatlarining to’zilishi bilan taqqoslasak ular orasida o’xshashlik borliqini
sezishimiz mumkin.

Biror bir ranglar aralashmasidan olish mumkin bo’lmagan ranglar asosiy ranglar deyiladi.

Qizil, yashil va ko’k ranglarl-asosiy ranglar hisoblanadi (1-rasm). Ularni bir hil

aralashtirsak
oq hosil
bo’ladi.

RGB modelining nomi Red - gizil, Green — yashil va Blue — ko’k birlamchi ranglarning
bosh xarflaridan olingan bo’lib, ushbu ranglarning turli proporsiyalarda aralashtirish natijasida
ko’rinuvchi spektrning turli hil boshqa ranglarini olish mumkin. Birlamchi ranglarning
aralashmasidan ikkilamchi moviy (cyan), pushti (magenta) va sarig (yellow) ranglar xosil
bo’ladi.

1-rasm. RGB modeli.
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RGB modelining tashkil etuvchilari 0 dan 255 gacha giymat gabul qilishlari mumkin.
R=255, G=255, B=255 bo’lganda oq rang, R=0, G=0, B=0 bo’lganda esa qora rang xosil
gilishimiz mumkin.

CMYK modeli (2-rasm) bo’yoqglarning nurni yo’tish qobiliyatiga asoslangan. Oq rangning
nur o’tuvchi bo’yoqdan o’tishida spektrning bir qismi yutiladi. Yutilmagan nur qaytadi va odam
ko’ziga tushadi.

2-rasm. CMYK modeli.

Ranglar moviy (Cyan), pushti (Magenta) va sariq (Yellow) ranglar aralashmasidan
paydo bo’ladi. Ularning to’liq aralashmasidan qora (blacK) rang xosil bo’ladi. Modelining
tashkil etuvchilari 0 dan 100 gacha giymat gabul gilishlari mumkin.

HSB(HSV) modeli. Model nomi o’nga asos bo’lgan uch komponentning bosh
xarflaridan olingan: Hue - rang toni; Saturation - to’yinganlik; Brightness - yorginlik. Model
odam ko’zining rangni xis qilish qobiliyatiga asoslangan.

Rang toni 0 dan 360 gradusgacha diapszondagi burchak kattaligi bilan tavsiflanadi.

To’yinganlik (yoki xromatiklik) rangning tozalik darajasidir. U kul rangning boshga
rangga nisbati bilan aniglanadi (0% - kul rang, 100% — to’la to’yingan rang). Rangning
yorginligi 0 dan 100 gacha o’zgarishi mumkin.

Adobe Photoshop dasturida uskunalar panelida ranglar bilan ishlash uchun to‘rtta uskuna
ajratilgan:

OSNOVNOY SVET. Ushbu oynasida ganday rang ko‘rsatilgan bo‘lsa, KOVSH,
LINIYA, KARANDASH, KIST, AEROGRAF va shuningdek, Alt klavishi bilan birgalikda
go‘llanganda PALES oynasi uchun o‘sha rang asosiy hisoblanadi. Osnovnoy svet oynasidagi
rang PIPETKA yoki ushbu oyna ustida «sichqoncha» tugmasini ikki marta ketma-ket bosish
orqgali o‘zgartiriladi.

SVET FONA. Ko‘satilgan rang LASTIK oynasi bilan ishlanganda go‘llaniladi. SVET
FONA oynasidagi rang OSNOVNOY SVET oynasida rangni o‘zgartirish uchun ganday amal
bajarilgan bo‘lsa, bunda ham huddi o‘sha amalga rioya gilish lozim yoki PIPETKA oynasi bilan
Alt klavishini birgalikda bosish orgali rangni almashtirish mumkin.

PEREKLYUCHENIYE SVETOV, kursorni ushbu oyna usida bir marta bosish orgali
asosiy rang va fon rangi o‘rin almashadi.

STANDARTNIY SVET . kursorni ushbu oyna ustida bir marta bosish orqgali asosiy rang
va fon rangini standart ranglar qora va oq rangga almashtiriladi.

Ranglarni tanlashda Adobe Photoshop dasturida Color yoki Swatches oynalaridan ham
foydalanish mumkin.

1=
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RGB (red, Green, Blue qizil, ko‘k, yashil) moduli tasvirni ekranda tahrir gilish nugtai
nazaridan kelib chiqgan holda juda qulay va u 24 razryadli ranglar platasi yordamida deyarli
barcha 16 million ranglarni monitorlarda aks ettiriladi. RGB ranglar majmuasi bilan ishlagan
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barcha tasvirlarni xoxlagan formatda diskka yozish mumkin. RGB ranglar majmuasidagi ayrim
ranglar umuman tabiatda uchramaydi.

CMYK - tabiatda mavjud bo‘lgan ranglar majmuasi, quyosh nurlari inson ko‘zlari ajrata
oladigan barcha ranglarni o‘ziga mujassamlashtirgan. Quyosh nurlari biror — bir jismga
tushganda uning ta’siri ostida inson ko‘zlari jism shakli va rangini idrok etadi. Misol uchun
binolarning o‘t o‘chirish burchaklariga osib go‘yilgan o‘t o‘chirgichlar to‘q ko‘k va zangori
ranglar bilan bo‘yalishiga garamay, bizning ko‘zimizga to‘q qgizil rangda ko‘rinadi. Ranglarni bir
biriga qo°shilishi natijasida boshga ranglar hosil gilinadi:

C — xavorang, M — binafsharang, Y - sariq rang, K - gora rang.

RGB ranglar majmui keng ko‘lamdagi ranglarni taklif etadi. Lekin ularning ko‘p gismi
(aynigsa, yorginlari) tasvirni chop etganda monitordagi bilan keskin farq giladi. Shu bois ham
ko‘plab mutaxassislar tasvirni chop etishdan avval uni CMYK tizimiga o‘tkazadilar. Ayrim
mutaxassislar esa tasvir bilan CMYK tizimida ishlashni maslaxat beradilar. Ammo bu tasvir
bilan ishlash turli giynchiliklar tug‘diradi. Ayni shunday giynchiliklardan biri — kompyuter juda
sekin ishlaydi. Bunga asosiy sabab Adobe Photoshop dasturi RGB tizimiga sozlangan bo‘lib,
har bir buyrugni bajarib, uni RGB tizimidan CMYK tizimiga almashtirguncha kompyuter
go‘shimcha vaqt talab giladi. Bundan tashgari, skaner va monitor RGB tizimida ishlashga
mo‘ljallangan. Ranglar bilan ishlovchi barcha uskunalar (rangli printerdan tashgari) RGB
tizimida ishlaydi. Shuning uchun yaxshisi tasvirni chop etishdan avval CMYK tizimiga o‘tkazib
olish magsadga muvofiq. Tasvir ustida barcha amallarni poyoniga yetkazib, menyular satrida
IZOBRAJENIYE — NASTROYKA tarkibidagi CMYK buyrug‘ini tanlang.

QATLAMLAR BILAN ISHLASH

Adobe Photoshop dasturi tasvirdagi biror obyekt PRYAMOUGOLNAYA OBLAST,
ELLIPTICHESKAYA OBLAST, LASSO, VOLSHEBNAYA PALOCHKA, BISTRAYA
MASKA yordamida tasvirdagi detallar belgilanib ularning nusxalari Adobe Photoshop dasturi
yangi gatlam hosil giladi. Bu gatlam alohida obyekt bo‘lib, uni tahrir gilish ham alohida tarzda
bo‘ladi. Bir necha tasvirlardagi ayrim detallarni yagona tasvirga jamlanganda Adobe Photoshop
dasturi ko‘chirib o‘tilgan tasvir bo‘laklarni gatlamlarga ajratadi. Ayni jarayon tasvir detallarini
joylashtirish uchun juda qulay. Bir necha gatlamlar bilan ishlaganda ularni boshqarish
giyinlashadi. Adobe Photoshop dasturi bajarilganda yangi oyna hosil bo‘ladi. Bu oynada
tasvirdagi yangi gatlamalar hagidagi axborotlar joylashgan. Yangi gatlam hosil gilinganda
Adobe Photoshop dasturi uni SLOY oynasida ro‘yxatga oladi. Bu oynada qatlamlar tartibli
tarzda joylashtiriladi. Shuningdek, gatlamalrning o‘rnini almashtirish yoki vagtincha o‘chirib
go‘yish mumkin. Qatlamlarni o‘chirish uchun avval kerakli gatlam SLOY darchasida belgilab
olinadi va menyular satrida sloy menyusi tarkibidagi UDALIT SLOY buyrugi tanlanadi.
Dasturda gatlamlarni bir-biriga birlashtirish imkoniyati xam mavjud.

MATNLAR BILAN ISHLASH

Photoshop dasturi tasvirlar ustiga matnlarni kiritish uchun yana bir keng imkoniyatni
ochib beradi. Tasvir ustiga matn kiritish uchun oynalar panelida maxsus Tekst oynasi mavjud.
Bu oyna asosan tasvirga turli mantlarni kiritish uchun xizmat giladi. Tekst oynasi tirkibida Tekst
mask, Vertikalniy tekst kabi oynalar yashiringan. Bu oynalar aktivlashtirilib, kursor tasvir ustida
bir marta bosilishi bilan yangi Testoviy instrument oynasi xosil bo‘ladi. Bu oynalar faqat
matnlar tuzish uchun xizmat giladi. Uning yordamida mavjud matnlarni tahrir gilishning iloji

yo'q.

Amaliy topshiriq
1. Adobe Photoshop dasturini ishga tushiring.
2. Adobe Photoshopda tayyor tasvir faylini oching.
3.Fayl ustida quyidagi amallarni bajaring.
e Tasvir rangini o‘zgartiring;
e Tasvirni ekrandagi ko‘rinishini kattalashtiring;
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e Tasvir rangi yorqinligini orttiring;

e Tasvirga tasvirga mos tekst kiriting;

e Tasvirning keraksiz gismlarini olib tashlang.

4. Xosil bo‘lgan tasvirga yangi nom bering.

5. Photoshop dasturidan o°zingiz uchun vizit kartochkasi yarating va uni Xxotirada
saglang.

6. Adobe Photoshop dasturi ishini yakunlang.

Octilgan mavzuni mustahkamlash uchun savollar
1. Adobe Photoshop dasturining vazifasi nimadan iborat?
2. Adobe Photoshop dastur ganday ishga tushiriladi va ishi yakunlanadi?
3. Adobe Photoshop dastur necha menyudan iborat va ularning vazifalarini ayting?
4. Adobe Photoshop dasturida ganday uskunalar paneli mavjud, ularning vazifalarini
ayting?
5. Matn bilan ishlash usulini ko‘rsating?
6. Ranglar bilan ishlash uchun nechta oyna mavjud, ularning vazifasini ayting?
7. Mustagqil ravishda biror bir rasm ustida amallar bajaring?

1 - amaliy mashg‘ulot
Adobe Photoshop dasturi bilan tanishuv.

Ishning magsadi: Adobe Photoshop dasturining imkoniyatlarini o‘rganish. Dastur
funksiyalari bilan tanishuv.

Vazifa:

1. Dasturning ishchi sohasi, uskunalar guruhi, funksional panellar, hamda ularning imkoniyatlari
bilan tanishuv.
Nazariy gism.

Dasturni ishga tushirish: Windows 95, 98, ME, 2000, XR ili NT operasion tizimida Pusk
tugmasiga bosing paneli zadach bo‘limida joylashgan Programs (Programmi) va u yerdan
Adobe Photoshop 7.0 elementi ustiga sichgoncha bilan bosing yoki Vse programmi
bo‘limiga kiring so‘ngra

|I| # Adobe Photoshop C5
ni joriy qiling.

Adobe Photoshop CS dasturi boshga dasturlar orasida superxit mahsulotga aylandi. Uni
ustiga bu dasturning har bir soni o‘zida yangi elementlarni mujassamlantirgan. Bu o‘zgarishlar
Photoshop 7.0 versiyasida xam kuzatiladi. Ishlab chigaruvchilar bu dasturdagi bir gator
kamchiliklarni bartaraf gilishdi, bularga Windows i Mac OS X. gismida, Photoshop 7 nihoyat
virtual xotira tizimni ishlashini o‘rgandi, natijada tezkor xotiraning bir gancha gismi tejab
golindi. Bu tejamkorlik katta xajimga ega bo‘lgan tasvirlar bilan ishlaganda seziladi. Shuningdek
operasion tizimni osilib golishi kamaydi. Hozirda Photoshop boshga bir gancha daturlar bilan
bir vagtda yaxshi ishlashi mumkin (1.1-rasm).
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"1.1-rasm, Photoshop CS ekran ko‘rinishi.

Rasmda Photoshop dasturida ishlash bo‘yicha amaliy ko‘rsatma keltirilgan. Ushbu oynadagi
tasvirni Zakrit tugmachasini bosamiz va quyidagi ishchi oyna hosil bo‘ladi (1.-rasm).

(@2n) o vse e mote  Okno  Crpasws

Ao _FIPAK

1.2-rasm. |

shci oyna.

Va bosh menyudagi Faylga kirib, yangi tasvir hosil gilish uchun Noviy bo‘limini joriy
gilamiz va quyidagi oyna hosil bo‘ladi (1.3-rasm)

NAT

£0

RN
AR

& x
8-

N

G|»:

E@

&
1
@
2
3

o

P

i

z

i

L}

=

q

8

a

9

B

#

@

i

H

&

3
£
Y
b

Userosoi npoduns:  Patouse npocTparcrse RGE: Adobe AGE (19

il

T e el 1

Mormukeensnan npanopus:  Keaapar ~

1.3-rasm.

Bu yerda fayl nomini (imya) satr gismiga kiritamiz. Masalan: pedagog. Va quyidagi
oyna joriy bo‘ladi (1.4-rasm).
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1.4-rasm.
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Photoshop va ImageReady dasturlariga tasvirni tez ko‘rib chigish moduli Kiritilgan.
Oldin esa bu ishni amalga oshirish uchun tashqi dastur (utilit)lar ishlatilardi. Masalan ACDSee
yoki ThumbsPlus. (PDA) cho‘ntak kompyuterlari uchun rasmni importi va eksporti WBMP
formatli filtrlari kiritilgan.  Kompyuterning ishlash chegarasi doirasida avtomatik tarzda
rasmning sifatini buzmagan xolda moslashuv (optimizasiya)ni bajaradi.

Photoshop dasturiga guruh (gruppovoy) bo‘lib ishlash uchun qo‘shimcha imkoniyatlar
kiritildi. Bu bir kompyuterda turli foydalanuchilar tomonidan Adobe dasturida ishlash
imkoniyatini beradigan AfterCast kengaytkich qo‘shildi. Agar bir foydalanuvchi tasvirga
o‘zgartirish kiritsa bir vaqtni o‘zida xamma foydalanuvchilar kuzata oladi. Ammo AfterCast
sozlash (nastroyka)ni fagat administrator boshgara oladi, lekin bu o‘z uy kompyuterlarida
Photoshop dasturida ishlovchi foydalanuvchilar bu muammoga duch kelmaydilar. Biz yuqgorida
fagatgina Photoshop CS ni asosiy imkoniyatlarini sanab chiqdik.

Uskunalar paneli(panel instrumentov)
Ekranda turgan dastur uskunalarini ishga tushirish uchun sichgoncha bilan uni ustiga

bosing va ekranda ko‘rinayotgan piktogrammani ustiga bosing. Bir xil piktogrammalar yonida
kichik ko‘rsatkich (strelochka)lar mavjud. Agar uni ustiga bosilsa tasvirga to‘g‘ri keluvchi oyna
(vsplivayushaya palitra)lar ko‘rsatiladi, u yerdan siz kerakli uskunalarni tanlashingiz mumkin.
Har bir uskuna uchun o‘zining o‘lcham (parametr)lari ekran teppasida joylashgan opsiyalar
panelida mavjuddir (1.5-rasm). Masalan, rejim smeshivaniya, znacheniye neprozrachnosti.
Photoshop dasturi ishga tushganda oynaning chap gismida uskunalar paneli joriy bo’ladi.

To’rtburchakli belgilash
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1.5-(a,b) rasm. Uskunalar panelida paydo bo‘luvchi maslaxat(podskazka) oynasi.

Eslatma:Edit>Preferences>Display&Cursors (Pravka> Ustanovki> Otobrajeniye &
kursori) oynasida kursor va uskunalar piktogrammalari ko‘rinishlarini sozlash mumkin.

Opsiyalar paneli (Panel opsiy. 1

Opsiyalar paneli har bir uskunaning parametrlarini sozlash uchun ishlatiladi (1.6- rasm)
masalan, shaffoflik darajasi yoki tasvirni almashtirish rejimi. Opsiyalar panelining o‘ng
tomonida maxsus ranglarni saglovchi bo‘lim mavjuddir. Parametrlarni ko‘rsatilishi gaysi rasmni
tanlanganiga bog‘lig (1.6-1.11-rasmlar). Foydalanuvchi tomonidan Kiritilgan tasvir ko‘rinishi
boshga o°zgartirishlar kiritilguncha saglanadi. Palitra va opsiyalar panelini xam ekranni istalgan
joyga siljitish mumkin.

l Brush: | Mode: [Hormmal =]  Opacity: [ioose [v] | Flow: [5os [*] _;;6‘ |

1.6-rasm. Brush uskunasi uchun opsiyalar paneli.

I o G I = Feather: ID P I™ anti-aliazed | Styla: [Normal =

1.7-rasm. Rectangular Marquee uskunasi uchun opsiyalar paneli.

| BN

EE ‘ ’ﬁﬂ e K3 | Mode: INormaI :I Oipacity: |
1.8-rasm. Gradient uskunasi uchun opsiyalar paneli

F Aute Add/Delete

.||EE§I ||T viE e ele e

1.9- rasm. Rep uskunasi uchun opsiyalar paneli

|3
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1.10-rasm. Rectangle uskunasi uchun opsiyalar paneli

| S

1.11-rasm. Ture uskunasi uchun opsiyalar paneli

Tz pt =] 2asharp =] |

IHeretica ;I IMedium ;I

Eslatma:Edit>Preferences>Display& Cursors (Pravka> Ustanovki> Otobrajeniye&
kursori) oynasida kursor va uskunalar panelidagi uskuna piktogrammasini tanlashingiz mumkin.

Va Opsiya panelining o‘ng tomonida aktiv uskuna piktogrammasi ko‘rsatilgan. Agar
piktogramma yonidagi strelka ustiga bosilsa, ko‘rinmay turgan menyu ochiladi, unda boshga
kerakli bo‘lgan uskunani tanlash mumkin. Bu jadvalga o‘zgartirishlar Kiritish mumkin ya’ni kam
ishlatilayotgan uskunalarni olib tashlab o‘rniga kerakli bo‘lgan uskunalarni joylash mumkin. Har
bir opsiyalar paneliga kiritilgan o°zgartirishlar avtomatik tarzda saglanib golinadi. Tugmalarni
gayta tiklash va joylashtirish uchun paydo bo‘luvchi paneldan amalga oshiriladi.

Paydo be ‘luvchi yordamchi maslaxatlar (vsplivayushiye podskazki)

Istalgan piktogramma ustiga sichgonchani bosmasdan olib boring shunda siz
ishlatmoqgchi bo‘lgan uskunaning nomi va uni Klaviatura orqali ishga tushiradigan tugmachalar
ko‘rsatiladi. Shu bilan bir gatorda ishlatilayotgan opsiyalar oynasi va uning vazifasi xagida
gisgacha ma’lumot olish mumkin (1.12- rasm). Edit > Preferences > General (Pravka >
Ustanovki > Obshiye) oynasidagi yordamchi maslahatlar oynasini ishlatish uchun Show Tool
Tips oynasi ustiga bayrogchani o‘rnating (Pokazivat vsplivayushiye podskazki).

JJlD,_b |v | | T Aute Select Layer [ Show Bounding Box | o= B= Ha |_'_. _","_.

|.-'l'-.ut0matic:all_l,l zelect a layer by clicking on a wisible pizel |

1.12-rasm. Opsiyalar panelidagi yordamchi maslaxatlar

Dasturning barcha komandalari uchun Asosiy menyu (Glavnoye menyu) mavjuddir:

[£y Adobe Photoshop - [6011_tif @ 100 (RGB]] _ (O] %

ﬁEile Edt Image Layer Select Filter “iew ‘window Help _|E’|£|
1.13-rasm. Asosiy menyu

Fayl (File) menyusi quydagi xolatlarda ishlatiladi: yaratish (sozdat), ochish (otkrit),
joylashtirish (razmestit), yopish (zakrit), saglash (soxranit), skanirlash (otskanirovat), import va
eksport, gog‘ozga chigarish (napechatat izobrajeniye), Faylni tarmoq orqgali uzatish (peredat fayl
po seti), bir nechta opsiyalarni avtomatlashtirish uchun va albatta Photoshop dasturidan chiqgish
uchun.

Pravka (Edit) menyusida, tasvirni redaktirlash yani sozlash uchun komandalar:
nusxalash (kopirovaniya), o‘zgartirish (transformasii), joylashtirish va tasvir ranglarini tusini va
mo‘ygalam galinligi va turini tanlash mumkin.

Rejim (Mode) menyusi orgali Image (Izobrajeniye) menyusi, tasvir sakkiz turdagi tasvir
urinishlarini tanlash mumekin.

Sloy (Layer) menyusida joylashgan komandalar, bir necha gatlamlardan joylashgan tasvir
ustidagi amallar yani: gatlamlar aro bog‘lanishni qatlamlar ketma-ketligini va gatlamlarni
umumiy gatlamga birlashtirish imkoniyatini beradi.

Videlit (Select) menyusida joylashgan komandalar— kerakli gatlamlarni tanlashda
ishlatiladi.

Filtr (Filter) menyusi o‘zida tasvirlarni birlashtirish va umumiy holga keltirish uchun
kerakli bo‘lgan filtiri mavjuddir.

Vid (View) menyusidagi komandalar, ekrandagi tasvirni ko‘rinishlarini nazorat giladi.
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Okno (Window) menyusi komandalari, zkrandagi boshga tasvirlarni aks ettiradi va
ulardan kerakli bo‘lgan paytda foydalanish imkonini beradi.

Pomosh (Help) menyusidagi komandalar foydalanuvchi uchun kerakli bo‘lgan
maslahatlar orgali ko‘mak va hozirda bajarish mumkin bo‘lgan imkoniyatlar bilan tanishtiradi.

Istalgan tasvirni xoxlagan paytda o‘zgartirishlar Kkiritish imkonini va 12 turdagi
Photoshop kengaytma(format)larida saglash imkonini beradi. Ammo odatta asosiy quydagi
Photoshop formatlari ishlatilad: TIFF, GIF, JPEG, EPS.

Photoshop dasturida ko‘pgina operasiyalar asasan politralar orqgali bajariladi. Ekranda
ko‘p joy egalamasligi uchun politralar o‘zaro guruhlarga biriktirilgan:

Navigator/Info (Boshgaruv/Informasiya), Color /Swatches/ Styles (Rang/ Namuna/
Uslublar), History/Actions/Tool Presets (Tarixi /Xarakatlar /Uskunalar tanlash), Layers/
Channels/Paths (Qatlamlar/Kanallar/Konturlar). Character/Paragraph (Shrift/ Abzas).

Palitralar (palitri)

Photoshop dasturida ko‘p operasiyalar palitralar orqgali bajariladi ularni o‘zaro
aralashtirish xam mumkin. Istalgan palitrani ochish uchun esa Okno (Window) menyu
komandasidan amalga oshiriladi.

Belgilangan palitra boshga shu guruhga kiruvchi politralardan eng yugorida avtomatik
tarizda joylashadi.

Photoshop dasturidan chigish: Windows Operasion dasturida bu dastur oynasini yopish
uchun Fayl>Vixod (File > Exit) menyusidan ko‘rsatilgan komandani tanlang yoki (Ctrl+Q)
tugmalar kombinasiyasini bosing

Nazorat savollari:

1. Adobe Photoshop CS dasturi ganday ishga tushiriladi?

2. Adobe Photoshop CS dasturining asosiy menyusi nimalardan tashkil topgan?
3. Opsiyalar paneli nima uchun ishlatiladi?

4. Palitra operasiyalari orgali nima bajarish mumkin?

2- Amaliy mashg‘ulot.
Adobe Photoshop dasturida tasvir va rasm bilan ishlash

Ishning magsadi: Skaner orqgali olingan tasvirni o ‘zgartirish va uskunalar paneli orqgali tasvirni
yaratish .
Vazifa:
1. Brush uskunalari bilan tanishish.
2. Brush uskunasi yordamida tasvirga shtrixlar va ozgartirishlar kiritish.
3. Matnli xujjat yaratish.

Nazariy gism.

Adobe Photoshop Windows muhitida ishlovchi Macintosh va IBM PC kompyuterlari
uchun mo‘ljallangan elektron ko‘rinishdagi foto tasvirlarni tahrirlovchi dasturdir.  Adobe
Photoshop dasturi Adobe System, Inc kompaniyasi tomonidan ishlab chigarilgan bo‘lib,
ishlatishdagi alohida qulayliklari bilan mashhur.

Adobe Photoshop tasvir tahrirlagichi yordamida fotosuratlarga go‘shimchalar Kirish,
fotosuratdagi dog‘larni o‘chirish, eski rasmlarni gayta ishlash va tiklash. Rasmlarga matn
kiritish go‘shimcha maxsus effektlar bilan boyitish, bir fotosuratdagi elementlarni ikkinchi
fotosuratga olib o‘tish, suratdagi ranglarni o‘zgartirish, almashtirish mumkin. Adobe Photoshop
imkoniyatlari keng gamrovli bo‘lib, u gazeta va jurnallarni turli-tuman rasmlar bilan boyitishda
juda katta qulayliklar yaratadi.

Adobe Photoshop aynigsa jurnalistlarning, rassomlarning, teatr sohasidagi xodimlarni
ijodiy imkoniyatlarini to‘la amalga oshirishlarida yordam beradi. Jurnalistika va bevosita
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matbuot yoki nashriyot sohasiga alogador bo‘lgan shaxslarning mazkur dastur bilan ishlashni
bilishi uchun go‘shimcha imkoniyatlarni yaratib beradi.

Adobe Photoshop tasvir tahrirlagichi juda murakkab dasturdir. Foydalanuvchilar uning
asosiy imkoniyatlaridagina foydalanadilar xolos. Opsiyalar panelida Brush (mo‘ygalam)
mo‘yqgalami uslubini tanlash uchun strelkasi ustiga bosing( 2.1- rasm). Har bir piktogramma
ustidagi ragamlar mo‘ygalamni qalinligini piksellarda ko‘rsatadi. Agar siz istalgan mo‘ygalam
ustiga olib borsangiz shu mo‘ygalamning qalinligi va turi xagida ma’lumot chigadi. (Boshga
turdagi mo‘ygalamlarni tanlash uchun 12-chi qismda keltirilib o‘tilgan «Mo‘yqgalamlar
kutubxonasini yuklash (Zagruzka biblioteki kistey)»). Mo‘ygalam panelini yopish uchun
paneldan tashqgaridagi ekranning istalgan joyga bosing va avtomatik tarizda panel yopildi.

H _‘E',_f( - || Brush: ;1 - | Mlade: IN-:-rmaI :I Crpacity: |
Master Diameter W @
o 4

A
2.1-rasm. Mo‘ygalam shaklini tanlash paneli

Mode (Aralashtirish rijimi ( Rejim smeshivaniya )) bo‘limini tanlang, xamda Opacity
(Shafofsizlik (Neprozrachnost)) bo‘limini foyz ko‘rsakichida Brush (Kist) uskunasi uchun
tanlang (2.2-rasm) garang. Agar ko‘rsatilgan gisim parametri 100% ni tashkil gilsa mo‘ygalam
shtrixi pastki piksellarni mutlog goplaydi.

Eslatma: Faqatgina shaffof bo‘lmagan gatlamlarni rangini o‘zgartirish uchun Layers
(Qatlam(Sloi)) palitrasidagi Lock transparent pixels (Zafiksirovat prozrachniye tochki) ustiga
bayroqgchani o‘rnating.

| Mada: INnrmaI :I Opacity: |

2.2-rasm. Opacity parametirini belgilash

Photoshop 7.0 dasturi yordamida siz birgancha standart mo‘ygalamlar yoki o‘zingiz
o‘lchamlari va ko‘rinishini Kiritgan xolda juda qizigarli rassomchilik ishlarini amalga
oshirishingiz mumkin(2.3- rasm).

Rasmlar bilan ishlash uchun yangi prosessor o‘ta gizigarli bo‘lgan rasmlarni yaratish
imkonini beradi. Photoshop 7.0 dasturida standart va avvaldan foydalanuvchi kiritgan rasmlarni
nusxalab unga sayqal berish shu bilan birga tasvirga xo‘l va qurugq mo‘yqgalam usullarida bezak
berish mumkin. Mo‘ygalam paketiga barg va o‘tlarni tasvirini yaratadigan maxsus effekt
mo‘yqgalamlari kitildi. Maxsus original tasvirlarni yaratish uchun skanerdan o‘tkazilgan rasm va
tekstlarni orga fon sifatida shaffof ko‘rinishda tasvirga kiritish mumkin. Photoshop 7 dasturi
prosessori fagat yangi tasvir yaratish imkoniyatlar bilan cheklanib qolmay balki, boshgaruvning
sodalashganligi e’tiborga olingan.
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2.3-rasm. Har xil turdagi mo‘ygalamlar bilan Brush uskunasi bilash chizilgan chiziglar.

Mavjud bo ‘Igan mo ‘yqalamni o ‘zgartirish(lzmeneniye sushestvuyushey kisti)

=

2.4-rasm. Brush Tip Shape bo‘limini tanlash.

Photoshop dasturiga go‘shimcha sifatida mo‘ygalamlar ombori xam beriladi va siz u
yerdan istalgan mo‘ygalamni tanlab uni Xxoxishingizga ko‘ra o‘zgartirish (modifikasiya)
gilishingiz mumkin.

Opsiyalar panelidan Brushes (Mo‘ygalam(Kist)) tugmasiga bosing undagi menyudan
Brush Tip Shape - sm. 2.4- rasm bo‘limini tanlang.

Diameter (Diametr) efektni kerakli joygacha cho‘zing yoki Mo‘ygalam diametirini
kiriting (1 dan 999 pikselgacha).

Mo‘yqalam izi shaffofsizligini belgilovchi Hardness (Qattiglik (Jestkost)) koeffisentini
tanlang yoki uni xam foyz miqgdorda kiriting (0-100% gacha).

Mo‘ygalam goldirgan izlari uzogligini Spacing (Interval) orgali bajariladi (0-999%)
foyz miqdorini oshirilgan sari shtrixlar orasidagi masofa katalashib boradi. Shuningdek bu
vazifani kursor yoki mo‘ygalam xam bajarishi mumkin, buning uchun Spacing (Interval)
tugmasidan bayrogni olib tashlashni o‘zi kifoya, ganchalik kursorni tez xarakatlantirsangiz
shuncha oraliq kattalashadi va aksi.

Eslatma: Ko‘pgina standart o‘rnatilgan mo‘ygalamlar uchun aosan Spacing i Diameter
bo‘limlarini o‘zgartirish mumkin.

5. Mo‘ygalam izini doira yoki boshqa ellips ko‘rinishlarini belgilash uchun Angle
(Burchak(Ugol)) bo‘limidan ( -180° dan +180° gacha) giymatlarni ko‘rsating yoki ekranning
chap tarafidagi rasmdagi strelkani xoxishga ko‘ra joylashtiring.

6. Mo‘ygalamni sochma yoki tiniglashtirish uchun Roundness (Okruglost) (0-100%)
parametrlarini bering foiz migdori ortgani sari nuqgta izi tiniglashadi.

Yangi mo ‘ygalamni yaratish (Sozdaniye novoy kisti)
Brush (Mo‘ygalam) menyusidan New Brush (Yangi mo‘ygalam) buyrug‘ini tanlang.
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Mavjud mo‘yqgalamni o‘zgartirish «lzmeneniye sushestvuyushey kisti» bo’limidan 2 dan
8 gacha bo‘lgan buyruglarni tanlang. Create New Brush (Yangi mo‘ygalamni yaratish)
bo’limiga bir marta bosing va kerakli o’lchamlarni bering agar siz ushbu tayyor mo‘ygalamni
saglab golmoqchi bo‘lsangiz uni nomini kiriting va OK tugmasini bosing. (Ammo bu Yangi
Mo‘yqgalam xech gaysi bibliotekaga kiritilmaydi.). Saglangan Mo‘ygalam piktogrammasi tanlash
panelida oxirida joylashadi.

Tasvirdan iborat bo ‘lgan mo ‘yqalamni yaratish(Sozdaniye kisti na osnove izobrajeniya)

1. Rectangular Marquee (Pryamougolnaya oblast) uskunasini aktivlashtirish uchun
klaviaturadan M tugmasini yoki Shift+M tugmalarini bosing.

2. Oqg fonda berilgan figuralar bilan tasvirni chegarasini belgilang (maksimum 1000x1000
pikselgacha).

3. Edit > Define Brush (Pravka > Mo‘ygalamni aniglash) komandasini tanlang.

4. Yuqgorida aytib o‘tilgandek ushbu yangi mo‘ygalamini kiriting va OK tugmasini bosing.
Bu mo‘ygalamdan Brush (mo‘ygalam) menyusi bilan ishlayotganda foydalanish mumkin. Paydo
bo‘luvchi mo‘ygalam o‘lchamlarini Spacing (Interval) tugmasidan shtrixlar orasidagi masofani
aniglashtiring (1-999%).

5. Belgilangan zonani gaytib o‘z xoliga keltirish uchun Ctrl+D tugmalarini birgalikda
bosing.

Mo ‘ygalamni o ‘chirish(Udaleniye kisti)
1. Mo‘ygalam tanlash panelini oching.
2. Birinchi usul: Alt tugmasini bosib turib o‘chirmogchi bo‘lgan mo‘ygalamni belgilang. Bu
xarakatni orgaga gaytarish(otmenit) mumkin emas.
Ikkinchi usul: Keraksiz bo‘lgan mo’ygalamni ko’rsating va Delete Brush (Mo‘ygalamni
o’churish) buyrugini tanlang 2.5- rasmga garang.

[T

Master Diameter IZD p< (D |

I = o MHew Brush...

Rename Brush...

Delete Bruszh

m ;1 Text Only
2.5-rasm. Mo‘yqalamni o‘chirish

100

L.

Background Eraser va Magic Eraser uskunalarini ishlatilishi

Magic Eraser (Mo‘jizaviy o‘chirgich) menyusi sichgoncha tugmasi bilan o‘chirish imkonini
beradi. U siz ko‘rsatgan ranga yaqin bo‘lgan piksellarni o‘chiradi.

Buni aksini esa Paint Bucket (Vedro s kraskoy) uskunasi bajaradi. Agar siz shaffofsizlikni
100% dan pastrog’ini tanlagan bo‘lsangiz unda Magic Eraser uskunasi orqgali kerakli joylani
shaffof ko’rinishga keltirishingiz mumkin.

|[[]

2.6-rasm. Magic Eraser uskunasining opsiyalar paneli

Tolerance: |22 | [ Anti-aliazed | ¥ Contiguous [T Usa All Layers | Cpacity: [1003 [ | |

Background Eraser (fon uchun o‘chirgish) asabobi bu fondagi keraksiz joylarni o‘chiradi
yoki kerakli ranga bo‘yaydi. Bu uskunaning ustunligi shundaki u bilan aralash fonlarni yakdil
xolatga va o‘chirilayotgan zonani yoki chegaralarni xamoxangligini nazorat giladi.

[

uuuuuuuuuu v Continuous
v LContiguous Once
Find Edges

2.7-Background Eraser uskunasining opsiyalar paneli.

Brush: H |L\rmls [contiquaus = |Ta\er’ance [50ss [v] IT Protect Foreground Color ‘ Sampling: [Continuous = |
D tig

Background Swatch
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Qatlamlarni zonalari uygunligi(Stiraniye chasti sloya)

1. Xoxlagan gatlamni tanlang. Eraser (uchirgich) uskunasi yordamida gatlamdagi keraksiz
joylarni o‘chirmoqchi bo‘lsangiz unda Lock transparent pixels (Zafiksirovat prozrachniye
tochki) bo‘limiga bayrogchani o‘rnating shunda o‘chirilayotgan gatlam undan oldingi gatlamni
foniga ega bo‘ladi. Agar Lock transparent pixels (Zafiksirovat prozrachniye tochki)
bo‘limidagi bayroqcha olib tashlansa unda o‘chirilgan gisim shaffof xolatga o‘tadi.

2. Eraser (uo‘irgich) uskunasini YE tugmasi yoki Shift+E tugmalarini birga bosib uni
ishga tushiring.

3. Opsiyalar panelidan Brush (Kist) bo‘limiga kiring va kerakli bo‘lgan mo‘ygalamni
tanlang.

Mode (Rejim) bo‘limidan kerakli rejimni tanlang: u yerda Brush (Mo‘ygalam), Pencil
(kalam) yoki Block (Blok) larni tanlang 2.8-rasmga qarang. Xo‘l bo‘yoqni akslantiruvchi
Brush (Kist) bo‘yash effektini tanlang. Opacity (Shaffofsizlik) parametrlarini ko‘rsating.

Made: m Flow: g;z\ ‘ I” Erase to History
v Brush
Pencil
Block

” AF | = || Brush: L AE
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2.8-rasm. Eraser uskunasining opsiyalar paneli.

Avtomatik uchirish rejimi (Rejim avtomaticheskogo stiraniya)
Auto Erase (Avtolastik) o‘z-o‘zidan avtomatik tarizda ishlashga mo‘ljalangandir agar siz

uning o‘z xoxishingizga ko‘ra ishlatmoqchi bo‘lsangiz quydagilarni bajarishingiz shart.

1. Kerakli bo‘lgan fon rangini tanlang. Bunda Eyedropper (Pipetka) uskunasidan rang
tashlashda foydalanishingiz mumkin.

2. Kerakli bo‘lgan gatlamni belgilang.

3. Pencil (Karandash) uskunasini aktivlashtiring, buning uchun V tugmasi yoki Shift+B
tugmalarini birgalikda bosing.

4. Opsiyalar panelidan Auto Erase (Avtolastik) uskunasi ustiga bayrogni o‘rnating.

5. Tasvtrga shtrixlarni chizing. Asosiy pikseldan boshlab kerakli xududgacha kursorni tortib
boring yoki boshgasiga maqul bo‘lgan pikseldan boshlashingiz mumkin.

Nazorat savollari:
1. Brush uskunasi imkoniyatlarini sanab bering.
2. Background Eraser buyrugi nima uchun ishlatiladi?
3. Obyekt rangi ganday o‘zgartiriladi?

3-amaliy mashg‘ulot
Matnlar bilan ishlash

Ishninng magsadi: Dastur funksiyalari bilan tanishish.
Vazifa:
1. Matn yaratish va uni tahrirlash.
2. Yaratilgan matnga effektlarni qo‘llash.

Nazariy qgism.

Photoshop 7 dasturida matn vektor ko‘rinishiga ega. Dasturda tekst o‘zining aniq
chegara va konturlariga ega chunki dastur matnlarni ishlatayotganda vektor konturini go‘llaydi.
Shu bilan bir gatorda matn xam rasm sifatlarini o‘zida mujassamlashtirgan. Bu matin printerdan
chiqarilishiga garamay u PDF yoki EPS formatlarida saglanashi va o°z tinigligini saglab goladi.

Photoshop dasturi fagatgina tekstlarni kiritibgina emas balki ularni yozilayotgan vaqgtida
va yozilgandan so‘ng xam ularni (tusini) rangini ko‘rinishi xamda yo‘nalishini o‘zgartirish
mumkin.
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Matnni Yaratish(Sozdaniye teksta)

Photoshop dasturida matn yozish uchun Ture buyrug‘i tanlanadi va avtomatik tarzda
kerakli joyda o‘z maxsus gatlamiga ega bo‘lgan fonda yozila boshlaydi. Istalgan paytda uning
ko‘rinishini o‘zgartirish mumkin. Masalan: shrift, uslub, kegl, rang, kerning, treking, oralikdagi
interval, to‘g‘irlash, matn chiziglarini hajmini. Bundan tashqari bir tekstni o‘ziga bir gancha
atributlarini kiritish mumkin (3.1- rasm).

3.1-rasm. Redaktirlanayotgan matn o‘zgartirish va effektlar qo‘lanilgan matn

Shu bilan bir gatorda tekstning manosini mexanik tarzda o‘zgartirish unga har xil effektlar
go‘llash va u joylashgan gatlam ustida bir gancha imkoniyatlarni go‘llash mumkin. Tekst gatlami
ustida ganday ammalar go‘llash mumkin? Unga fitrni go‘llash, tekstdan tozalash va raslarga
to‘ldirish mumkin. Bu ammalarni bajarish uchun eng avvalo tekst gatlamini Layer > Rasterize
> Ture (Sloy > Preobrazovat v rastroviy format > Tekst) uskunasi orqali belgilab undagi
komandani tanlash kerak. 3.2- rasmda eng avvalo uni aktivlashtirib so‘ngra filtr va turli gatlam
effektlari go‘lanilgan.

3.2- rasm. Matnni yozilish chegarasini aniglash.

Eslatma: Bitmap, Indexed Color i Multichannel, rijimida yaratilgan tekst uz gatlamiga
ega bulmaydi va tugridan tugri ekran foniga tushadi va uni taxrirlam imkoniyati yo‘goladi.

Turli xildagi tekstlar (tahrirlanadigan va tahrirlanmaydigan) ko‘rinishlari Ture (Tekst),
Layer (gatlam), Character (Shrift), Paragraph (Abzas) uskunalari va opsiyalar paneli orgali
yaratiladi (3.3-rasm).

[T[]| & | Fses = Fewr 5| Mo =] afee 0 (== 0 £ | O
3.3-rasm. Ture uskunasining opsiyalar paneli.

Tahrirlanadigan matn gatlamini yaratish(Sozdaniye redaktiruemogo tekstovogo sloya)

1. Engavvalo Ture (Tekst) uskunasini T tugmasini bosish bilan aktivlashtiring.

2. So‘ngra tekstni joylashtirish kerak bo‘lgan ekrandagi gisimni o‘lchamlarini sichqoncha
orgali belgilang(so‘zlar va tekstlar bir-biriga to‘gnashib ketmasligi kerak). Yaxshisi har bir
so‘zni alohida gatlamga yozing shunda ularni bir-biridan mustaqil ravishda siljitish imkoni
go‘lga kiritasiz.

3. Opsiyalar panelida quydagi ishlarni bajaring:

o  Ture tugmasiga bosing va tekstning yo‘nalishini ko‘rsating(gorizontal, vertikal);

o Shiriftlar oilasini, uslubini keglni tanlang;

Shuningdek Anti-aliased (Moslashtirish) menyusidan tekst gatlam chegarasini ko‘rsating:
Sharp (Tinig) Crisp (gattig), Strong (kuchli), yoki Smooth (yumshoq). Bu tekstni soyasini
ko‘rinishlarini tubdan o‘zgartiradi va tasvirga moslaydi.

Alignment (Viklyuchka) tugmalaridan biriga bosing va kerakli bo‘lgan tekstni yozilish
chegarasini ko‘rsating (o‘ngdan, chapdan, o‘rtadan) (3.4- ramga) garang.
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3.4-rasm. Tekstni tekslash usullari

Opsiyalar panelidan tekstni rangini ko‘rsating. Bundan tashqari tekst rangini Swatches

(Obrazsi) va Colors (Sveta) palitralaridan xam belgilash mumkin.

4.  Ekrandagi oynada tekstni Kiriting.

5. Yangi tekst gatlamini yaratish uchun Enter tugmasini bosing agar sizga boshga gatlam
kerak bo‘lmasa Esc tugmasini bosing.

Maslahat: Agar siz tekstlar bilan ishlayotganda kompyuter osilib golaversa yoki tezligi
pasaysa unda ochilgan golgan kerak bo‘lmagan shirift oynalarini yoping shunda dastur tezligi
oz holiga keladi.

Maslahat: har safar teks yozishda yangi gatlamdan foydalanganingiz maqul va xatolikka
ega bo‘lgan gatlamlarni o‘chirib tashlang.

Tekstni tahrirlash. Tekstga o‘zgartirishdan oldin uni aktivlashtiring va matndagi siz
jumla va xarifni belgilab o‘zgartirish kiriting, shuningdek tekstni belgilash uchun tekst ramkasini
ustiga bosish kifoya.

Tekstni masshtablash (Masshtabirovaniye teksta)

Horizontal Scale (Masshtab po gorizontali) i Vertical Scale (Masshtab po vertikali)
buyruglaridan tekstni joylashish shaklini o‘zgartirish uchun foydalaning. Bir xil to‘g‘ri
ko‘rinishdagi masshtablash uchun quydagi ammalarga rioya giling:

Macmrat Do BepTHEKaJIM
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Macwrat o INOPMSOHTAaJIM

3.5-rasm. Masshtabni kiritish 3.6-rasm. Tekst masshtabini o‘zgartirishdan
keyngi holat
Tekst uchun maxsus effektlar(Spesialniye effekti dlya teksta)

Eng avvalo quydagilarni eslab qoling. Agar siz tekstni ramkasini, masshtabini xajmini va
tuzilishini o‘zgartirish uchun uni tahrirlanadigan ko‘rinishda bajarishingiz kerak va so‘ngra
tekstga maxsus effektlar go‘shish uchun uni rasm sifatiga keltirib so‘ngra effektlarni
go‘llashingiz mumkin.

V tugmasi orqgali ishga tushuriluvchi Move (Siljitish) uskunasi orgali tekstni
trasformasiya gilish mumekin.

Show Bounding Box (Pokazat gabaritnuyu ramku) uskunasiga bayroqgchani o‘rnating
Layers (Sloi) uskunasi orgali kerakli gatlamni belgilang. Ekranda tekst gatlami aks etadi.

Yakka holda kiritilgan jumla va so‘zlarni quydagicha o‘zgartirish mumkin:

Layers (Qatlam) oytasiga jumlani kiriting va Edit (Pravka) menyusidan Free Transform
(Proizvolnaya transformasiya) buyrug‘ini tanlang;

Sichgoncha bilan tekst oynasini kerakli shaklni olguncha surib boring bu vazifani boshga
uskunalar yordamida xam bajarish mumkin.

Matnni tavsir va matn orgasida joylashtirish (Otobrajeniye teksta pozadi sloya s risunkom)
1.  Tekstli gatlamni yarating.
2. Shu tekst gatlamidan nusxa oling va uni saglab qo‘ying.
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3. Tekst nusxasini belgilanig va Layer>Type>Convert to Shape (Sloy > Tekst >
Preobrazovat v figuru) komandasini tanlang. Tekst gatlami avtomatik rasmga aylanadi va uni
tahrirlash endi mumkin emas.

4. Layer>Change Layer Content>Levels (Sloi>lzmenit soderjimoye sloya>Urovni)
komandasini tanlang 3.7-rasmga garang. Yozmagan gatlam siz boshga gatlamni kiritmagunizcha
nusxalash omborida goladi va aktiv bo‘lib turadi.

5. Yozilgan tekst boshka tasvirlar bilan xamoxangligini jigarang tusga ega bo‘lgan
piktogramma Input (Vvod ) ustiga bosing va tekst rangini ochartiring yoki to‘gartiring.

normal [=] opacity: [ioozs [v

Lock: R | Fil: [1oogs [

&0l O P G ;.'iﬂv/,J o S
3.7-rasm. 3.8-rasm.

6. OK tugmasini bosing (3.8-rasm). Ekraning fonnidan bir gismiga bosing.
Ko ‘rinmaydigan matnlar yaratish (Sozdaniye ischezayushego teksta)

1.  Tekst Kkiriting va uni gatlamini aktiv holatda goldiring.

2. Layers (gatlam) oynasining pstki gismidan Add a mask (Dobavit masku) tugmasini
bosing. Belgilangan joy yonida kichik belgi (maska) paydo bo‘ladi.

3. G Kklavishasini yoki Shift+G tugmalar kombinasiyasini bosgan holda Gradient
(Gradiyent) uskunasini ishga tushiring.

4.  Gradient uskunasi yonidagi strelkani bosing va kerakli rangni tanlang. Linear gradient
(Lineyniy gradiyent) tugmasiga bosing va Normal (Normalniy) rejimini tanlang shaffofsizlik
giymatini bering(1% dan100% gacha).

5. Tekstni ustiga kerakli bo‘lgan xududni ramka sifatida sizqoncha bilan belgilang va shu
gismlar ocharadi yoki to’karadi 3.9- ramsga garang.

Fad ~
Effect
3.9-rasm. Ko‘rinmaydigan tekst 3.10-rasm. Qatlamga turli effektlarni go‘lanishi

Maslaxat. Tekstni effekt bilan ko‘chirish uchun u joylashgan gatlamni aktivlashtiring va
Move (Peremesheniye) uskunasini ishga tushiring.

Maslaxat. Agar siz effektni o‘zgartirmoqchi bo‘lsangiz tekst joylashgan gatlam ustiga
bosing shunda Layer Style mulogot oynasi paydo bo‘ladi va undan boshga effektlarni
tanlashingiz mumkin.

Tekst gatlamini chegaralarini o ‘rash (Obvodka tekstovogo sloya)

Blending Options (Opsii smeshivaniya) paydo bo‘luvchi oynasidan Layers (Sloi)
buyrug‘ini tanlang.

Style (Stil sloya) oynasining chap tarafida joylashgan Stroke (Obvodka) buyrug‘i ustiga
bosing va Preview (Predvaritelniy prosmotr) uskunasiga bayroq o‘rnatilganligini tekshiring. U
yerdan quydagi bo‘limlarni ko‘rib chiging va kerakli o‘lchamlarni bering: Structure (Struktura)
Size (O‘Icham), Position (Joylashish holati) (ular tashgaridan va ichkaridan bo‘lishi mumkin.
Outside (Snaruji), Inside (Vnutri) yoki Center (markazdan)), Blend Mode (Rejim
smeshivaniya), Opacity (Shaffofsizlik), Fill Type (bo‘yash usuli) i Color (rang) 3.11- rasmga
garang.

OK tugmasini bosing (yoki Enter tugmasini bosing).
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3.11-rasm. Tekstga Stroke effektini Gradient bo‘yog‘i bilan go‘lanilishi.

Nazorat savollari:
Dasturda matn konturini o‘zgartirish uchun gaysi buyruglardan foydalaniladi.
Qaysi uskuna yordamida Photoshop dasturida matnlarni yaratish mumekin.
Gradient (Gradiyent) uskunasi gaysi tugmalar yordamida ishga tushiriladi.

4-amaliy mashg‘ulot.
Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar (sloy) bilan ishlash.

Ishning magsadi: Photoshop dasturida gatlamlar bilan ishlashni o‘rganish.
Vazifa:
Qatlamlar xagida tushuncha va yangi gatlam yaratish.
Xosil gilingan gatlam ustida bir nechta ammalar bajarish.
Xosil gilingan kama gatlamlarni o“chirib tashlash.

Nazariy gism.

Qatlamlar xudi oyna gatlamlariga o‘xshagandir fagat tasvir bo‘lgan joylarigina
ko‘rinishga egadir. Har bir gatlam uchun o‘zining shffoflik darajasi bo‘lib uni undan oldingi va
keyingi turgan gatlamlar bilan xamoxangligini moslash mumkin. Qatlamlarni joylashish o‘rnini
almashtirish yoki ularni yagona gatlamga birlashtirish mumkin. Bir vaqtni o‘zida har xil
gatlamlarda turgan tasvirni birgalikda o‘zgartirish va bir gatlamda turgan rasmni fagat bir
gismini o‘zgartirish mumkin emas.

Layers (Sloi) oynasida gatlamlar ustida turgan gatlamdan eng tagidagi gatlamgacha aks
etirilgan. Bunda fon gatlami oxirida joylashadi (4.1-rasm). Hozirda belgilangan gatlam aktiv
bo‘lib ko‘rinadi va fagat shu gatlam utida amallar bajarish mumkin.

Istalgan gatlamni aktivlashtirish uchun tartiblanish oynasidan uni ustiga bosish kerak
aktiv bo‘lgan gatlam nomi dastur nomi yonida akslanib turadi.
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4.1-rasm. Layers palitrasi

Eslatma: Katta xajimdagi tasvirlar bilan ishlayotganda bajarilib bo‘lgan gatlamlarni
birlashtirgan yoki o‘chirib tashlash maqul shunda dastur ishlash tezlik unimdorligi oshadi va
tasvir xajmi kamayadi.

Yangi gatlam hosil gilish(Sozdaniye novogo sloya)

1. Eng avvalo 100% shaffof gatlam hosil gilish uchun Create New Layer tugmasi ustiga
bosing.

2. Agar gatlamni o‘lchamlarini o‘zingiz bermoqchi bo‘lsangiz unda Alt, tugmasini bosib
turgan xolda Create New Layer tugmasini bosing va quydagicha yo‘l tuting:

3. Name (Imya) bo‘limida gatlamni nomini kiriting Group With Previous Layer
(Sgruppirovat s predidushim sloyem) bo‘limiga bayrogchani o‘rnating.

4. Layers (Sloi) palitrasidan ko‘z va mo‘ygalam Kko‘rinishidagi piktogrammalarga
bayrogchani o‘rnating.
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Mode (Rejim smeshivaniya) va Opacity (Neprozrachnost) parametrlaridan tasvir uchun
yangi parametrlarini bering (keynchalik bu parametrlar ozgartirilishi mumkin).
5. OK tugmasini bosing. Yangi gatlam ishlatilayotgan gatlam ustida paydo bo‘ladi.
Eslatma: Tasvir xajmini kamaytirish uchun Layers (Sloi) menyusidan Palette Options
(Opsii palitri) buyrug‘ini tanlang va shu tasvirga to‘g‘ri keladigan eng kichik xajmni tanlang.
Belgilangan gismni gatlamga aylantirish (Prevrasheniye videlennoy oblasti v sloy)
1. Belgilangan gismni hosil giling.
2. Layer > New > Layer Via Soru (Sloy > Noviy > Posredstvom kopirovaniya) menyusidan
komandani bajaring (Ctrl+J tugmalari).
3. Tasvirni belgilangan gismini yulib olib tashlash uchun Layer > New > Layer Via Cut (Sloy
>Noviy > Posredstvom virezaniya) komandasini bajaring 4.2-rasm(Ctrl+ Shift+J tugmalari).

4.2-rasm. Layer 1 xiralashtirilgan fondan xosil gilingan tasvir.

Qatlamni siljitish(Peremesheniye sloya)

Layers (Sloi) oynasida o‘zgartirish kiritmokchi bo‘lgan gatlamni belgilang.
Move (Peremesheniye) uskunasini aktivlashtiring(V klavishasi).

Qatlamni kursorni ushlabturgan xolatda gatlamni siljiting(4.3 va 4.4- rasm).

-1; ~ *;v
B Move B

4.3-rasm. Amaldagi tasvir 4.4-rasm. Matnli gatlamni Move
uskunasi yordamida siljitish.

Primechaniye: Auto Select Layer (Avtovideleniye sloya) bo‘limida bayrogcha turgan
bo‘lsa Move (Peremesheniye) uskunasi yordamida tezda gatlamni siljitish mumkin, ammo bu
sijitish shaffofligi 50% dan kam bo‘lgan bo‘lgan gatlamlar uchun ishlamaydi.

Qatlamlar bilan ishlash uchun uskunalar (Instrumenti dlya raboti so sloyami)
Barcha uskunalar gatlamlar bilan ishlaydi, lekin bu bilan gatlamning shaffofsizligiga
katta tasir o‘tkazadi shuning uchun gatlam shaffofsizligini doimo nazorat qilib turing.
Qatlamni o ‘chirish(Udaleniye sloya iz nabora)
Qatlamni o‘chirishdan oldin uni nomini aktivligini tekshiring va uni belgilab o‘chirib tashlang.
Qatlamga effektlar go ‘llash(Primeneniye effektov sloya)

Qatlamga quydagi maxsus effektlarni qo‘llash mumkin: Drop Shadow (Otbrosit ten),
Inner Shadow (Vnutrennyaya ten), Outer Glow (Vneshneye svecheniye), Inner Glow
(Vnutrenneye svecheniye), Bevel and Emboss (Skos i relyef), Satin (Atlas), Color Overlay
(Nalojeniye sveta), Gradient Overlay (Nalojeniye gradiyenta), Pattern Overlay (Nalojeniye
uzora) va Stroke (Kayma). Effektlarni istalgan paytda istalgancha istalgan gatlamga go‘llash
mumkin, lekin gatlamni shaffofsizligini tekshirib turing.

Eslatma: Uslub(stili) va effektlarni bir-biri bilan chalkashtirib yubormang. Uslub (Stil) —
bu bir gancha gatlam effektlarini xamoxangligidir.

Effektlar Layer Style (Stil sloya) mulogat oynasi orgali amalga oshiriladi.
Effekt yonidagi galochka bu effekt shu gatlamga go‘lanilganini ko‘rsatadi. Qatlam effektlarini
asosiy fon uchun go‘llash mumkin emas.
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Xamma gatlamlarni birgalikda ishlatish (Zadeystvovaniye vsex sloyev).

Agar opsiyalar panelida quydagi uskunalar ishlatilayotgan bo‘lsa: Blur (Razmitiye),
Sharpen (Rezkost), Smudge (Pales), Paint Bucket (Vedro s kraskoy), Magic Eraser
(Volshebniy lastik) ili Magic Wand (Volshebnaya palochka) unda Use All Layers (Ispolzovat
vse sloi) bo‘limiga bayroqchani o‘rnating shunda rang va boshga o‘lchamlar olinayotganda
mavjud bo‘lgan ranglarga yaqgin bo‘lgan tuslar birinchi navbatta ko‘rinadi. Fagat aktiv bo‘lgan
gatlamda ranglar o‘zgaradi.

Ikki gatlamni birlashtirish (Sliyaniye dvux sloyev)

Birlashtirmoqchi bo‘lgan ikki gatlamdan qgaysi birisi oldinroq bo‘Isa uni belgilang.

Layers (Sloi) menyusidan Merge Down (Slit s nijnim) komandasini belgilang yoki
Ctrl+E  tugmalarini birgalikda bosing. Aktiv gatlam o‘zidan pastda turgan gatlam bilan
birlashadi. Bir gancha belgilangan gatlamlarni birlashtirish uchun Merge Layer Set (Slit
nabor.sloyev) komandasini tanlang.

Qatlamlarni birlashtirish (Obyedineniye sloyev)

Diqqgat: Flatten Image (Ploskoye izobrajeniye) komandasi gatlamlarni pastdan boshlab
birlashtiradi va yashirilgan gatlamlarni avtomatik tarzda o‘chiradi.

Xamma gatlamlar ko‘rinib turganligiga amin bo‘ling va qaysi gatlam aktiv bo‘lishi
muxim emas.

Layers (Sloi) menyusidan Flatten Image (Ploskoye izobrajeniye) komandasini tanlang.
Agar dasturda bekitilgan gatlamlar bo‘lsa unda ogoxlantirish beriladi va OK tugmasini bosing va
birlashtirishni davom etiring. Agarda pastki gatlamlarda ko‘rinmaydigan nuqtalar bo‘lsa ular ok
ranga Kiradi.

Qatlamni o ‘chirish(Udaleniye sloya)

Layers (Sloi) menyusidan keraksiz gatlam nomini tanlang. Sngra Trash (Korzina)
tugmasini bosing va Yes (Da) tugmasini xam bosing.

Qatlamni o‘chirishni yana bir usuli keraksiz gatlam nomi ustiga olib borib sichkonchani o‘ng
tugmasini bosing va menyudan Delete Layer (Udalit sloy) bo‘limini tanlang xamda Yes
tugmasini bosing.

Nazorat savollari:
1. Qanday usulda gatlamlar xosil kilinadi?
2. Qatlamlarga kanday effektlar kulash mumkin?
3. Ajratilgan kisimda yangi gatlamni xosil kilishni ko‘rsatib bering.

Laboratoriya ishlarini bajarish uchun variantlar

1-variant
1. Ishchi oynada yangi fayl ochish tartibini yozma bayon gilib bering.
2. Yangi ishchi oyna oching va fayl nomini o‘z ismingiz bilan atang. Oyna o‘lchamlarini
(800x600) qilib o‘rnating va tagfonini rangli qilib tanlang. Ishchi oynada uskunalar panelidan
foydalanib ellips ko‘rinishidagi sohani ajrating va uning ichiga ARXITEKTOR degan yozuvni
gorizantal yoysimon shaklda yozib joylashtiring.

2-variant
1. Ishchi oynada so‘nggi faylni ochish tartibini yozma bayon qilib bering.
2. Shtamp uskunasidan foydalanib fototasvirning aynan nusxasini uning yonida yarating.

3-variant
1. Ishchi oynada yangi faylni xotiraga saqlash tartibini yozma bayon gilib bering.
2. Berilgan fototasvirni [Shift]+[Alt]+[Ctrl] tugmalari majmuasidan foydalanib ishchi oynasida
nusxasini hosil giling.

4-variant
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1. Ishchi oynada yangi fayl ochish tartibini yozma bayon qilib bering.
2. Rasmni to‘rtta qilib nusxalang va yonma-yon hamda tagma-tag joylashtiring va «Sloy»
menyu bandidan foydalanib har bir gatlamga alohida effekt bering.

5-variant
1. Ishchi oynadagi faylni boshqga joyga girgib nusxalash tartibini yozma bayon qilib
bering.
2. «Sloy» menyu bandidan foydalanib har bir gatlamlarga berilgan effektlarni Ubrat vse effekti
buyrug‘i orqali bekor qiling va Udalit sloy buyrug‘i orqgali birinchi va uchinchi qatlamlarni
o‘chirib tashlang.

6-variant
1. Ishchi oynadagi faylni boshga joyga to‘g‘ridan-to‘g ri nusxalash tartibini yozma bayon qilib
bering.
2. Berilgan fototasvirda uchinchi ko‘zni yasash amalini [Alt] tugmasi va Shtamp
uskunasidan foydalanib bajaring.

7-variant

1. Ishchi oynada xolstni burash tartibini yozma bayon gilib bering.
2. «Izobrajeniye» menyu bandi Rejim papkasi yordamida berilgan rangli tasvirni quyidagi
rejimlarda ifodalang: 1) Og-qora; 2) Dvusvetniy;
3) Multikanalniy; 4) Bitoviy.

8-variant
1. Ishchi oynada «Izobrajeniye» menyu bandida xolstni o‘lchamlarini o‘rnatish tartibini yozma
bayon qilib bering.
2. Yangi ishchi oyna oching va fayl nomini o‘z ismingiz bilan atang. Oyna o‘lchamlarini
(300%x400) qilib o‘rnating va tagfonini rangsiz qilib tanlang. Ishchi oynada Alanga so‘zini yozib
olovli yozuvni hosil giling.

9-variant
1. Uskunalar panelini o‘rnatish tartibini yozma bayon qilib bering.
2. Yangi ishchi oyna oching va fayl nomini o‘z ismingiz bilan atang. Oyna o‘lchamlarini
(400x400) qgilib o‘rnating va tagfonini rangli qilib tanlang. Ishchi oynada ARXITEKTOR degan
yozuvni yozib Stili mulogat oynasi yordamida turli effektlar bering.

10-variant
1. Uskunalar panelini o‘rnatish tartibini yozma bayon qilib bering.
2. «Filtr» menyu bandidan foydalanib turli dizaynli yozuvlarni hosil giling.

11-variant
1. Tasvirning to‘la ekranli ko‘rinishini hosil gilish tartibini yozma bayon qilib bering.
2. Fototasvirni montaj gilish uchun uning o‘Ichamlarini (3x4),(6x9),(15x18)
shakllarida tasvirlang.
12-variant
1. Tasvirni to‘laligicha belgilash va inkor qilish tartibini yozma bayon qilib bering.
2. Yangi ishchi oyna oching va fayl nomini o°z ismingiz bilan atang. Oyna o‘lchamlarini V3
qgilib o‘rnating va tagfonini rangli gilib tanlang. Ishchi oynada qor tagida golgan yozuvni tuzing.

13-variant
1. Tasvirni alohida ajratib belgilash va inkor gilish tartibini yozma bayon gilib bering.
2. Berilgan fototasvirni lIzobrajeniye menyu bandi Xolst papkasi yordamida turli yo‘nalishlar
bo‘yicha buring va yonma-yon joylashtiring.
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14-variant
1. Tasvirning dublikat nusxasini yaratish tartibini yozma bayon gilib bering.
2. Ixtiyoriy tasvirni tanlang va tasvirni turli ramkalarga joylashtiring hamda tag gatlam bilan
birlashtiring.

15-variant
1. Adobe onlayn buyrug‘ining vazifasini yozma bayon qilib bering.
2. Yangi ishchi oyna oching va fayl nomini o‘z ismingiz bilan atang. Ishchi oynada nur
taratayotgan gullar tasvirini hosil giling.

16-variant
1. Tasvirga turli yozuvlarni joylashtirish tartibini yozma bayon gilib bering.
2. Yugoridan pastga nur taratib tasvirni yoritayotgan lampochka tasvirini yasang.

17-variant
1. Yangi ochilayotgan oynaning o‘lchamlarini o‘rnatish tartibini yozma bayon qilib bering.
2. Shaxmat doskali sirtgi hoshiyasi ko‘k va ichki hoshiyasi sariq gilam tasvirini yasang.

18-variant
1. Yangi ochilayotgan oynani tagfonini rangli gilib o‘rnatish tartibini yozma bayon qilib bering.
2. Yangi ishchi oyna oching va fayl nomini o‘z ismingiz bilan atang. Oyna o‘lchamlarini
(8x10) qilib o‘rnating va tagfonini rangli qilib tanlang. Ishchi oynada uskunalar panelidan
foydalanib nagshli ko‘rinishidagi sohani ajrating va uning ichiga ARXITEKTOR degan yozuvni
to‘lginli yoysimon shaklda yozib joylashtiring.

19-variant
1. Yangi ochilayotgan oynani tagfonini rangsiz oq gilib o‘rnatish tartibini yozma bayon qilib
bering.
2. Gul tasviri tushirilgan sirtgi hoshiyasi ko‘k , ichki hoshiyasi och qizil ramkali gilam tasvirini
yasang.

20-variant
1. Yangi ochilayotgan oynani tagfonini tinig(shaffofli) gilib o‘rnatish tartibini yozma bayon
qilib bering.
2. Shaxs siymosi tushirilgan gilam tasvirini yasang.

21-variant
1. Trasformatsiya buyrug‘ining vazifasini yozma bayon qilib bering.
2. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga chagirib oling
va «Filtr» menyu bandi Vo‘chitaniye buyrug‘idan foydalanib uning biror bo‘lagini qirqib oling.

22-variant
1. Lasso qurilmasiga yozma izoh bering.
2. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga chagirib oling
va «Filtr» menyu bandi Sjijeniye buyrug‘idan foydalanib uning biror bo‘lagini ajratib cho‘zish
ishlarini bajaring.

23-variant
1. Adobe Photoshop redaktoriga yozma izoh bering.
2. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga chaqgirib oling
va «Filtr» menyu bandi Render (bermoq) buyrug‘idan foydalanib fotomanzarani qorongulikda
to‘rt xil rangli manzarada (Circle of Light) shaklida yoriting.

24-variant
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1. Adobe Photoshop redaktori menyusiga yozma izoh bering.

2. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga

chagqirib oling va «Filtr» menyu bandi Render (bermoq) buyrug‘idan foydalanib fotomanzarani
gorongulikda to‘rt xil rangli manzarada (Blue Omni - avtoko‘k) shaklida yoriting.

25-variant
1. Adobe Photoshop redaktor ihagida tushuncha.
2. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga chagirib oling
va «Filtr» menyu bandi Render (bermoq) buyrug‘idan foydalanib fotomanzarani qorongulikda
(Default-majburiyatsizlik) shaklida yoriting.

Photoshop dasturidan foydalanib variant topshiriglarini
bajarish uchun amaliy ko’rsatmalar.

1-topshiriq

Photoshop dasturidan foydalanib turli shaklli yozuvlarni figuralar bo‘ylab
hosil gilish:

1. Yangi ishchi oyna oching, uni oz ismingiz bilan nomlang, oyna o‘lchamlarini Latter
o‘lchamida tanlab oling va tagfonini shaffofrang qilib tanlang. Hosil gilingan ishchi oynada
to‘rtburchakli ramkaning rasmini chizing, uning ichiga ARXITEKTOR vyozuvini vertikal
yoysimon shaklda yozib figura o‘rtasiga joylashtiring.

2. Yangi ishchi oyna oching, uni o‘z ismingiz bilan nomlang, oyna o‘lchamlarini
(1280x720) o‘lchamida tanlab oling va tagfonini rangli qilib tanlang. Hosil qilingan ishchi
oynada uskunalar panelidan foydalanib ellips ko‘rinishidagi sohani hosil qiling, uning ichiga
ARXITEKTOR yozuvini gorizantal arka shaklida yozib figura o‘rtasiga joylashtiring.

3. Yangi ishchi oyna oching, uni o‘z ismingiz bilan nomlang , oyna o‘lchamlarini
(640x480) o‘lchamida tanlab oling va tagfonini rangsiz qilib tanlang. Hosil kilingan ishchi
oynada uskunalar panelidan foydalanib ellips ko‘rinishidagi sohani hosil qiling, uning ichiga
ARXITEKTOR yozuvini gorizantal quyiga yoysimon (umensheniye duga) shaklida yozib
figura o‘rtasiga joylashtiring.

Bajarish bo’yicha amaliy ko’rsatma:
1) Dasturni ishga tushirganimizdan so‘ng «Fayl» menyu bo‘limiga kirib «Noviy» buyrug‘ini
bajarilishga o’tamiz yoki [CTRL]+[N] tugmachalar majmuasidan foydalanamiz. Natijada
yangi fayl nomini va parametrlarini ko‘rsatish uchun mulogat oynasi ochiladi.
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Biz «Imya» degan joyida fayl nomini ko‘rsatamiz: masalan Grafika. So‘ngra
o‘lchamlarini tanlaymiz «Standartniye razmeri» oynasiga kirib Latter yozuvini tanlaymiz.
So‘ngra rejim: «Cherno-beloye»; Soderjaniye: «Prozrachniy». Keyin [OK] tugmasini
bosamiz , ekranda biz tanlagan oyna hosil bo‘ladi.

Uskunalar panelidan «Uskuna forma(U)» tugmachasiga sichqoncha ko‘rsatkichini
keltirib chap tugmasini bosamiz va uskunalar gatorida uning forma belgilari hosil bo‘ladi kerakli
ramkani tanlab ishchi oynada ushbu shaklni hosil gilamiz. ARXITEKTOR yozuvini vertikal
yoysimon shaklda joylashtirish uchun tekst o‘lchamini 43 qilib tanlaymiz. So‘ngra
sichgonchaning o‘ng tugmasini bosib hosil bo‘lgan kontekstli menyudan «Deformatsiya teksta»
buyrug‘ini ishga tushiramiz va ekranda «Iskajeniye tekst» mulogat oynasidan «Stil»ga
duga(yoy) va «Vertikal» yozuvlarini tanlab [Ok] tugmasini bosamiz va tekstni yozamiz.

[= (=) [5<]

2) Dasturni ishga tushirganimizdan so‘ng «Fayl» menyu bo‘limiga Kirib «Noviy» buyrug‘ini
bajarilishga uzatamiz yoki [CTRL]+[N] tug‘machalari majmuasini ishga tushiramiz. Natijada
yangi fayl nomini va parametrlarini ko‘rsatish uchun mulogat oynasi ochiladi. Biz «Imya»
degan joyida fayl nomini Kko‘rsatamiz: masalan teatr; So‘ngra o‘lchamlarini tanlaymiz
«Standartniye razmeri» oynasiga kirib (1280x720) yozuvini tanlaymiz. Keyin rejim: «Cherno-
beloye»; Soderjaniye: «Svetniye» parametrlarini o‘rnatib, [OK] tugmasini bosamiz, ekranda
biz tanlagan oyna hosil bo‘ladi. Uskunalar panelidan kerakli ellipsni tanlab, ishchi oynasida
ellipsli sohani hosil gilamiz. ARXITEKTOR yozuvini gorizantal arka shaklida joylashtirish
uchun tekst o‘lchamini 43 qilib tanlaymiz. So‘ngra sichqonchaning o‘ng tugmasini bosamiz va
hosil bo‘lgan kontekstli menyudan «Deformatsiya teksta» buyrug‘ini ishga tushiramiz. Ekranda
«Iskajeniye tekst» mulogat oynasidan «Stil»ga arka va «Gorizantal» yozuvlarini tanlab [Ok]
tugmasini bosamiz, keyin tanlangan matnni yozamiz.
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3) Dasturni ishga tushirganimizdan so‘ng «Fayl» menyu bo‘limiga Kirib «Novoy» buyrug‘ini
bajarilishga uzatamiz yoki [CTRL]+[N] tugmachalari majmuasini ishga tushiramiz. Natijada
yangi fayl nomini va parametrlarini ko‘rsatish uchun mulogat oynasi ochiladi. Biz «Imya»
degan joyida fayl nomini ko‘rsatamiz: masalan Sanjar ; so‘ngra o‘lchamlarini tanlaymiz
«Standartno‘ye razmero‘» oynasiga Kirib (640x480) yozuvini tanlaymiz. So‘ngra rejim:
«Cherno-beloye» ; Soderjaniye : «Beloye» parametrlarini o‘rnatib, [OK] tugmasini bosamiz ,
ekranda biz tanlagan oyna hosil bo‘ladi. Uskunalar panelidan «Polzovatelskiy uskuna
forma(U)» tugmachasiga sichgoncha ko‘rsatkichini keltirib chap tugmasini bosamiz va
uskunalar qgatoridan kerakli formani tanlab, ushbu Ko‘rinishli sohani hosil qilamiz.
ARXITEKTOR vyozuvini gorizantal quyiga yoysimon (umensheniye duga) shaklda
joylashtirish uchun tekst o‘lchamini 43 qilib tanlaymiz.So‘ngra sichqonchaning o‘ng tugmasini
bosib hosil bo‘lgan kontekstli menyudan «Deformatsiya teksta» buyrug‘ini ishga tushiramiz va
ekranda «Iskajeniye tekst» mulogat oynasidan «Stil»ga umensheniye duga va «Gorizantal»
yozuvlarini tanlab [OK] tugmasini bosamiz, keyin tanlangan matnni yozamiz.

@ 100% (CepbiA)
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2-topshiriq
1. Adobe Photoshop redaktorini ishga yuklang birorta manzarani ishchi oynaga chaqirib oling
va «Filtr» menyu bandi Vichitaniye buyrug‘idan foydalanib uning biror bo‘lagini qirqib oling.

Bajarish tartibi
Vichitaniye buyrug‘idan foydalanib rasmga ishlov beramiz. Buning uchun «Fayl»
menyu bandi Otkrit buyrug‘idan foydalanib kerakli obyektni chagirib olamiz.

o kb _scsing. jpx, @ 6%, 7% [RGE)

_____ 8 WORSL..
1-rasm. Lake_moraine (ko‘l bo‘yida).

So‘ngra «Filtr» menyu bandiga kirib, Vichitaniye (ayirish, ajratib olish) buyrug‘ini
bajarilishga uzatamiz. Ekranda Extract (ko‘chirma, parcha) mulogat oynasi hosil bo‘ladi. Uning
chap yon tomonida quyidagi uskunalar joylashadi:

1) galam-bo‘yaash yoki belgilash uchun;
2) Zalivka-rangni quyish-to‘kish yoki birdaniga to‘liq bo‘yash;
3) Lastik-o°chirgich;
4) Lupa-tasvirni kattalashtirish(+) yoki kichiklashtirish(-) va boshqga
uskunalar.
O‘ng yon tomonida quyidagi buyruqglar o‘z ifodasini topadi:

Ok tugmachasi bosilsa ushbu amallar bajarilishga uzatiladi; Cancel tugmachasi bosilsa
esa amallar bajarilishi inkor gilinadi.

Keyin Toll Options (erkin uskuna) bo‘limiga kirib ishlatilayotgan uskunaning Brush
Size (kist o‘lchami) o‘lchamini va navbatdagi bo‘limdan rangini hamda fonini tanlab olib unga
ishlov berishimiz mumkin.

2 Bes anenn-1 @ 66,7% (Coon 1 ,AGB)

2-rasm. Shaklning ajratib olingan gismi.
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5-rasm. Qirqgib olingandan keyigi manzara.

3-topshiriq

22 Lo mrac i 1 b 60, 0% [Cnof 1 KA

TEEELSTE
6-rasm. Tabiat manzarasi (ko‘l bo‘yida).
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Ushbu tabiat manzarasini tanlab olamiz. «Filtr» menyu bandi Sjijeniye buyrug‘idan
foydalanib tog* manzaralarini o‘zgartiramiz va quyidagi manzarani hosil qilamiz.

0k bes W HK-1 @ 66, 7% (Caok 1 ,1G8)

=B

8-rasm. Tundlashtirish(g‘uborlashtirish)

quyida berilgan rasmlardan foydalanib ikkinchi rasmdan obyektning bir bo‘lagini girgib olib
birinchi obyektga olib o‘tib joylashtiramiz va gatlamlarni birlashtirib yangi obyekt hosil gilish.
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@ 66,7% (RGB)

12-rasm. Ishlov berilgandan keyingi holati.
4-topshiriq

Fototasvirni aynan nusxalash.
Fototasvirni aynan nusxalash uchun ixtiyoriy tasvirni ishchi oynasida ochamiz va
yonidan uning nusxasini hosil gilamiz.
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Bajarish tartibi: «Fayl» menyu bandidan Otkrit buyrug‘i yordamida kompyuter
xotirasida mavjud yoki biror ma’lumot kirituvchi(skaner) orqali, yoki biror ma’lumot
tashuvchilar(CD-R, DVD-R, Flesh disk) orgali kiritilgan rasmlardan birini ochamiz va
uskunalar panelidagi Shtamp(Shtamp kopii) uskunasini aktivlashtirib tasvir ustiga sichqoncha
ko‘rsatgichini keltirib [Alt] tugmachasini bir marotoba bosamiz.

' 4.1-rs. Tsvirning dastlabki ko‘rinishi.

So‘ngra sichgoncha ko‘rsatgichini fototasvir yoniga keltirib chap tugmachasini bosamiz
ekranda shtamp ko‘rinishi va undan ma’lum masofada tasvir ustida plyus(+) shaklidagi belgi
hosil bo‘ladi. Sichgoncha ko‘rsatgichini tasvir da Ushbu belgiga garab harakatlantiramiz.
Shtamp siljigan joylarda tasvirning aynan nusxasi hosil bo‘ladi.

4.2-rasm. Tasvirning aygash nusxasi.

5-topshiriq

Fototasvirdan yoki boshga obyektdan nusxa ko‘chirishbuning uchun tasvirning ustiga
sichqoncha ko‘rsatgichini keltirib qo‘yib [Shift]+[Alt]+[Ctrl] tugmalari majmuasini bosib
turigan holda sichgonchaning chap tugmasini bosib turgan holda, istagan yo‘nalishga
harakatlantiramiz va [Shift]+[Alt]+[Ctrl] tugmalarini ko‘yib yuboramiz.

se=vE enll |

5.1-rasm. Tasvirning dastlabki shakli
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6-topshiriq
Rasmni to‘rtta gilib nusxalash va yonma yon hamda tagma tag joylashtirishni amalga oshiring.
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Rasmni ko’chirilgandan keying shakili.

7-topshiriq
To‘rtta gatlamda turgan rasmlarga alohida gatlamlar sifatida garab har biriga turlicha
effektlar berish.
Birinchi gatlam ustiga sichqoncha ko‘rsatgichini go‘yib chap tugmasini bir marotobo
bosamiz va «Sloy» menyu bandiga kirib Effekti sloya papkasidan Atlas effektini tanlaymiz va
OK tugmasini bosamiz.
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Xuddi shunday ikkinchi gatlamga ramka,uchinchi gatlamga va to‘rtinchi gatlamlarga ham
kerakli effektlarni tanlab quyidagi ko‘rinishdvgi tasvirni hosil gilamiz.
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8-topshiriq

«Sloy» menyu bandidan foydalanib gatlamlarga berilgan effektlarni Ubrat vse effekti
buyrug‘i orgali bekor gilish va Udalit sloy buyrug‘i orgali birinchi va uchinchi gatlamlarni
o‘chirib tashlash

«Sloy» menyu bandiga kirib Udalit sloy papkasidan Sloy buyrug‘ini ishga tushiramiz va
ekranda «Udalit sloy «Fon kopii 3» degan mulogat oynasi hosil bo‘ladi. Agar DA tugmachasini
bossak ko‘rsatilgan gatlamni olib tashlaydi, NET tugmachasini bossak amalni bekor giladi. Biz
shu jarayonni davom ettirib birinchi va uchinchi gatlarlarni foni bilan, birgalikda o‘chirib
tashlaymiz. Natijada quyidagi shaklga ega bo‘lamiz.
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Bundan tashgarii biz hosil gilingan to‘rtta qatlamlarni bita yagona gatlamga
birlashtirishimiz mumkin. Buning uchun «Sloy» menyu bandidan Obyedinit s Vidimim
buyrug‘i yoki [Shift]+[Cnrl]+[E] tugmachalari majmuasini ishga tushirish orgali bajarish
mumkin. Bu amaldan so‘ng har to‘rtala qatlam ham yagona bita qatlamga aylanadi. +uyida turtta
gatlamning birlishtirilgan holati.
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9-topshiriq
Berilgan fototasvirda odamga uchinchi ko‘zni yasash. Buning uchun fototasvirni ishchi
oynaga chaqirib olamiz va uskunalar panelidan Shtamp uskunasini aktivlashtiramiz. Uning
Shtamp kopi (S) yordamchi uskunasini aktivlashtiramiz. Tasvir ustiga sichqoncha ko‘rsatgichini
keltirib [Alt] tugmachasini bosing.

e e e S ey

Chers RN RN

Sichgoncha ko‘rsatgichini  ko‘z chiziladigan joyga qo‘yying, ko‘z ustida uni
akslantiruvchi (+) belgisi hosil bo‘ladi. Shu ko‘rsatgichni sichqonchaning chap tugmasini qo‘yib
yubormasdan ko‘zning butun sathi bo‘ylab harakatlantiramiz.
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Shtamp kisti o‘lchamini gancha katta tanlasak, shakl shuncha tez yasaladi. Ba quyida
chizilgan shakl yaratiladi.
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10-topshiriq

Berilgan rangli tasvirni turli rejimdagi ko‘rinishlarda tasvirlash
Fototasvirni ekranda ochamiz keyin «Izobrajeniye» menyu bandidan Rejim papkasiga
kiramiz va ko‘rsatilgan buyruqlarni tanlab ketma-ket bajaramiz.

MyreTixanara it KUpo0emm Apvuperiutt mYTsnt s

11- topshiriq

Olovli yozuvlarni hosil gilish

Bunday yozuvlarni hosil gilish ko‘proq dizaynerlar uchun qo‘l keladi. Uni tuzish uncha
murakkab emas. Dastlab fayl menyu bandini ochamiz, Noviy buyrug‘i yoki [Ctrl]+[N]
tugmalari majmuasini ishga tushiramiz va Yangi oyna ochamiz. Oyna foni oq bo‘lsin . Matnni
uskunalar panelidagi T belgisini aktivlashtirib gorizantal yo‘nalishda yozamiz. Matnning
o‘lchamini va shaklini tanlaymiz va rangini qizil yoki sariq rangda tanlaymiz. ~Effekt berish
uchun avvalo uni «Sloy» menyu bandiga kirib Skleit sloy buyrug‘i orgali tag gatlamga
mahkamlaymiz. So‘ngra «Filtr» menyu bandi orgali effektlaymiz.

Bundan tashqgari Flitr menyu bandi yordamida ham turli dizaynli yozuvlar tuzish mumkin

ALANGA ALANGA

ALANGA

Yozuvlarga Stili oynasi yordamida effekt berish
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Tasvirning dastlabki shakli

SEIS SEICYY

.

Tasvirning ishlov berilgandan keying holatlari.

Berilgan fototasvirni turli yo‘nalishlar bo‘yicha burash va joylashtirish

12-topshiriq

Avvalo yangi ishchi oynani ochib SHOW yozuvini tuzib olamiz va uni tag gatlamga
mahkamlaymiz. Endi qorni hosil gilamiz. Kist uskunasini uskunalar panelidan aktivlashtirib
olamiz. Kist uskunasi yordamida gorni hosil gilamiz.

13-topshiriq

Fototasvirning o‘lchamlarini o‘zgartirish
Izobrajeniye menyu bandidan Razmer lzobrajeniya buyrug‘ini ishga tushiramiz va
ekranda tasvir va quyidagi mulogat oynasi hosil bo‘ladi.
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Xuddi shu yo‘l bilan istagan o‘lchamli rasmlarni yasash mumkin.

14-topshiriq

Tasvirlarni turli ramkalarga solish
Buning uchun kerakli tasvir ishchi oynada ochiladi va ramkaning shaklini uskunalar
panelidagi Polzovatelskiy uskuna uskunasi orgali tanlaymiz. Kerakli ramkani tanlab tasvirga
kiydiramiz va Sloy menyu bandidan Skleit sloy yoki Obyedinit s Vidimim buyruglari orgali
mahkamlaymiz.
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Gulni yoritayotgan lampochka tasviri

Gilam tasvirini yasash

Nazorat uchun savollar
1. Adobe Photoshop dasturining vazifasi nimadan iborat ?
2. Adobe Photoshop dastur ganday ishga tushiriladi va tugallanadi ?
3. Adobe Photoshop dastur nechta menyu bandidan iborat va vazifalarini ayting ?
4. Adobe Photoshop dasturida ganday qurollar paneli mavjud, ularning vazifalarini ayting ?
5. Matn bilan ishlash usulini ko‘rsating ?
6. Ranglar bilan ishlash uchun nechta uskuna ajratilgan, ularning vazifasini ayting ?
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Test savollari
1. Adobe Photoshop dasturini ishga tushirish uchun gaysi tugmalar majmuidan foydalniladi.
a) Pusk-Programmi - Standartniy-Adobe Photoshop
b) Pusk-Programmi-Adobe Photoshop
c) Pusk-Programmi - Avtozagruzka-Adobe Photoshop
d) Pusk-Bce mporpammei- Adobe Photoshop CS

2. Adobe Photoshop dasturining vazifasi nimadan iborat.
a) Matnlarni hosil gilish va tahrirlash

b) Tasvirlarni hosil gilish va tahrirlash

c) Fototasvirlarni hosil gilish va tahrirlash

d) Fotosuratlarni gayta ishlash

3. Komryuter grafikasi necha turga bo‘linadi.
a)4ta
b) 3 ta
c)5ta
d) 2ta

4. Fototasvir bilan ishlovchi dastur nomini ko‘rsating.
a) Paint

b) Corel Draw

c¢) Adobe Photoshop

d) Adobe Photoshop CS

5. Dastur menyusi necha gismdan iborat.
a)9

b) 8

c) 10

d)7

6.Tasvir yuzini asosiy rang bilan bo‘yashda gaysi buyrug ishlatiladi.
a) Nastroyka sveta

b) Zalit

¢) Transform

d) RGB

7. Dublikat buyrug‘ining vazifasi.
a) Tasvir ranglarini sozlash

b) Rang modellarini o‘zgartirish
¢) Tasvirdan nusxa olish

d) Tasvirni nusxa qo’yish

8. Internet bilan bog‘lanishda gaysi buyruq ishlatiladi.
a) Import

b) Eksport

¢) Adobe online

d) Internet

9. Adobe Photoshop dasturida tasvirning real o‘lchami necha % ni tashkil etadi.
a) 100% b) 150% c) 200% d) 75 %
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10.Tasvirga matn Kiritish uchun gaysi uskuna ishlatiladi.

fat!

o B [ 0) d) I‘-“'|

11.Masshtab uskunaining vazifasi nima.
a) Kattalashtirish, kichiklashtirish

b) To’g’ri chiziq chizish

¢) Matnlarni kiritish

d) Matlarni qirgib olish

12.Tasvirni bo‘yashda gaysi uskunadan foydalaniladi.

!

a) b) |* c) d) o ‘

13. @ ushbu tugmaning vazifasi ko‘rsating.
a) Tasvirdagi yorginlik pasayadi

b) Tasvirdagi yorginlik ortadi

c) Tasvirdagi yorginlik o‘zgarmaydi

d) to’g’ri javob yo’q

14. Adobe Photoshop dasturidan chigishda gaysi tezkor tugmalar ishlatiladi.
Q) ALT+F6  b) ALT+F8 ) ALT+F4 d) ALT+F5

15. Protsessori ganaga bilgan kompyuterlarga Photoshop dasturi irnatilishi mumkin.
A) Pentium B) IBM C) Macintosh D) Ava S

16. Tezkor xotira gancha bo’lishi kerak ?
A) 32 Mbaytdan kam bilmasligi kerak
B) 16 Mbaytdan kam bilmasligi kerak
C) 64 Mbaytdan kam bilmasligi kerak
D) AvaB

16. Diskdagi bish joy gancha bo’lishi kerak ?
A) 125 Mbaytdan kam bilmasligi kerak

B) 56 Mbaytdan kam bilmasligi kerak

C) 64 Mbaytdan kam bilmasligi kerak

D) AvaB

17. Videoadapter necha rangda bo’lishi kerak ?
A) 256 B) 16 C)56 D) 128

18. Operatsion sistema ganday bo’lishi kerak ?
A) Windows 95 B) Windows 98 C) Windows 3.1 D) AvaB

19. Macintosh kompyuterlarini sistemasi ganday bo’lishi kerak ?

A) Software 3.0 B) Software 8.0 C) Software 7.0 D) AvaB
20. Kompyuterda Cd — Rom bo’lishi zarurmi ?

A)ha B)Yo’q C) Shartemas D) AvaB
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21. Tovush xaritasi zarurmi ?
A) ha B) Yo’q C) Zaruremas D) AvaB

22. Photoshop da yaratilgan fayllar kengaytmasi ?
A) *.PDF B) *.PSD C) *.JPG D) *.GIF

23. Menyu bo’limlari gaysi bandda to’g’ri ko’rsatilgan ?
A) File Yedit Image Layer Filter View Window Help
B) File Edit Image Filter View Window Help
C) File Edit Image Filter View Help
D)BvaV

24. Qirqib (&h buyrug’i gaysi instrumentda joylashgan ?
A) 2
B) [l
o) Bl

D) To’g’ri javob yo’q

25. Sehrli tay_oqcha instrumenti gaysi javobda to’g’ri ko’rsatilgan ?
A) 2
B) [l
s) 2l
D) 24

26. Aralashtirish instrumentini ko’rsating ?
A) 2o
B) LAl
0 ¥
D) 2

27. Lasso irﬂumentini ko’rsating
A) ZE
B) LAl
0 ¥
D) £

28. Aerograﬂlstrumentini Kirsating

A) %

5 [
o =
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) 2.
29. Ixtiyoriy belgilash instrumentini kirsating
A) 2o

p) [
o ¥l
p) [%]
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30. Qalam instrumentini ko’rsating?

» 2
5 [#
o &

D) Ll

31. Matn kiritish instrumentini ko’rsating?

» 4l
5 B
o &

D) L

32. Ogqartirish instrumentini ko’rsating?
n 2
)
0

D) L.
33. Masshtab instrumenini ko’rsating?

» H
5 &
o &

D) L
34. Instrumentlar paneli oynaning gayerida joylashadi ?

A) Menyu pastida

B) Oynaning o’ng gismida

C) Oynaning pastki gismida

D) Oynaning chap gismida

35. Photoshop 6.0 versiyasida menyu bilimlari gaysi bandda to’g’ri ko’rsatilgan ?

A) Fayl,Pravka, Redaktiovaniye, Izobrajeniye, Sloy, Videleniye, Filtr, Vid, Okno, Pomoshs
B) Fayl, lzobrajeniye, Sloy, Videleniye, Filtr, Vid, Okno, Pomoshs

C) Fayl, Redaktiovaniye, Izobrajeniye, Sloy, Filtr, Vid, Okno, Pomoshs

D) Fayl, Redaktiovaniye, 1zobrajeniye, Sloy, Videleniye, Filtr, Vid, Okno, Pomoshs

36. Photoshopni ishga tushirish

A) Pusk—> Programmi—> Adobe — Photoshop
B) Yorlig orqali

C) A vaB tigri

D) To’g’ri javob yo’q
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37. Fayllarni import va eksport gilganda ganday kengaytma bilan uzatadi ?
A) *.PDF
B) *.TIFF
C) To’g’ri javob yo’q
D)AvaB

3
38. 'LEI—I instrumenti nima vazifa bajaradi.

A) Joriy rang B) Rangni o’zgartiradi C) Ava B to’g’ri D) To’g’ri javob yo’q

Foydalanilgan adabiyotlar:
1. D. Mironov «Corel Draw 10». Uchebniy kurs. Sankt-Peterburg. 2002 god.
2. A.Tays «Adobe Illustrator-9». Uchebniy kurs. Sankt-Peterburg. 2002 god.
3. G.Pankratova «Photoshop 6». Uchebniy kurs. Sankt-Peterburg. 2002 god.
4. A.Sattorov «Informatika va axborot texnologiyalari». Toshkent. «O’qituvchi»
nashriyoti. 2003 yil.
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